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The Agilent Technologies 16717A 333 MHz State/2 GHz Timing Zoom
logic analyzer offers 2M deep memory and very fast sample rates - up
to 2 GHz for areas around the trigger - with up o 340 channels.

“Getting Started” on  » “Step 1. Connect the logic analyzer to the device under test” on page 13
page 11 + “Step 2. Choose the sampling mode” on page 14
* “Step 3. Format labels for the probed signals” on page 17
+  “Step 4. Define the trigger condition” on page 20
® “Step 5. Run the measurement” on page 21
» “Step 6. Display the captured data” on page 22
“Task Guide” on *  “Prghing the Device Under Test” on page 33
pags 3

*  “Choosing the Sampling Mode” on page 36
¢ “Selecting the Timing Mode {Asynchronous Sampling)” on page 36
s “Selecting the State Mode (Synchronous Sampling)” on page 43
¢ “In Either Timing Mode or State Mode” on page B2
e “Using 2 GHz Timing Zoom” on page 54
¢« “Formatting Labels for Logic Analyzer Probes” on page 57
e “Setting Up Triggers and Running Measurements” on page 64
e “Using Trigger Functions” on page 65
¢ “Using State Mode Trigger Features” on page 70
e “Editing the Trigger Sequence” on page 72
¢ “Editing Advanced Trigger Functions” on page 77
e “Saving/Recalling Trigger Setups” on page 84
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“Solving Logic Analysis Problems” on page 108
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Getting Started

After you have connected the logic analyzer probes to your device
under test (see “Step 1. Connect the logic analyzer to the device under
test” on page 13), any measurement will have the following basic steps:

11
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Chapter 1; Getting Started
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“Step 2, Choose the sampling mode” on page 14

“Step 3. Format labels for the probed signals” on page 17
“Step 4. Define the trigger condition” on page 20

“Step 5. Run the measurement” on page 21

“Step 6. Display the captured data” on page 22

If you have previously saved a logic analyzer setup to a configuration
file, or if configuration files are included with an analysis probe, you
can load the configuration file to set up the logic analyzer and define
the frigger condition.

Once you have made a logic analyzer measurement, the measurement
can be refined by repeating steps 4 - 6.

Next: “Step 1. Connect the logic analyzer to the device under test” on
page 13

12
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Chapter 1: Getting Started
Step 1. Connect the logic analyzer to the device under test

Step 1. Connect the logic analyzer to the device
under test

Before you begin setting up the logic analyzer for a measurement, you
need to physically connect the logic analyzer to your device under test.

There are several ways to connect logic analyzer probes to the device
under test:

e Using the general-purpose probes, the standard flying lead set, and
grabbers to connect to pins and leads in the device under test.

¢ By designing connectors (headers) into the device under test so that logic
analyzer probe cables and termination adapters can plug in directly.

¢ By designing connectors (headers) and terminations into the device under
test so that logic analyzer probe cables can plug in directly.

e [Jsing an analysis probe to connect to microprocessors and standard
buses.

When using an analysis probe, the Setup Assistant guides you through the
comnection and setup process for your particular logic analyzer and
analysis probe.

‘When connecting logic analyzer probes to the device under test:

1. Attach the logic analyzer probes to the device under test in a way that
keeps logically-related channels together.

2. Be sure to ground each pod.

Next: “Step 2. Choose the sampling mode” on page 14

13
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Step 2. Chouse the sampling mode

Step 2. Choose the sampling mode
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Set up state clock

There are two logic analyzer sampling modes to choose from: timing
mode and state mode.

In timing mode, the logic analyzer samples asynchronously, based on
an internal sampling clock signal.

In state mode, the logic analyzer samples synchronously, based on a
sampling clock signal (or signals) from the device under test. Typically,
the signal used for sampling in state mode is a state machine or
microprocessor clock signal.

To choose the sampling mode

1. Inthe Sampling tab, choose Timing Mode or State Mode.

14
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Chapter 1: Getting Started
Step 2. Choose the sampling mode

lf you chose Timing Mode

Select the timing analyzer full/half channel configuration.

Typically, you can choose a half-channel configuration with faster
sampling and greater memory depth, but with half of the channels.

Set the sample period.

To capture signal level changes reliably, the sample period should be less
than half (many engineers prefer one-fourth) of the period of the fastest
signal you want to measure.

If you chose State Mode

Select the state analyzer speed configuration (if there is a configuration
option).

In the Clock Setup, using the Master only mode, specify which clock signal
edges from the device under test will be used as the sampling clock.

www.valuetronics.com
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Chapter 1; Getting Started
Stap 2. Choose the sampling mode

You can also specify clock input signal levels (from the device under test)
that will enable (qualify) the sampling clock.

In either sampling mode
1. Specify the trigger position.

The trigger is the event in the device under test that you want to capture
data around.

Specify whether you want to look at data after the trigger (Start), before
and after the trigger (Center), before the trigger (End), or use a
percentage of the logic analyzer’s memory for data after the trigger (User
Defined). '

2. Set the acquisition memory depth.

If you need less data and want measurements to run faster, you can limit
the amount of trace memory that is filled with samples.

Next: “Step 3. Format labels for the probed signals” on page 17

16
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Step 3. Format labels for the probed signais

Step 3. Format labels for the probed signals
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When a logic analyzer probes hundreds of signals in a device under
test, you need to be able to give those channels more meaningful
names than "pod 1, channel 1",

The Format tab is mainly for assigning bus and signal names {from the
device under test)}, to logic analyzer channels. These names are called
labels. Labels are used when setting up triggers and displaying
captured data.

The Format tab also lets you do things like assign pod pairs to one or
two logic analyzers and specify the logic analyzer threshold voltage.

The Format tab has activity indicators that show whether the signal a
channel is probing is above the threshold voltage (high), below the
threshold voltage (low), or fransitioning.

17
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Chapter 1: Getting Started
Step 3, Format lahsls for the probed signals

To assign pods to one or two logic analyzers

A logic analyzer’s pod pairs can be assigned to one or two separafe
logic analyzers or they can be left unassigned.

1. Inthe Format tab, select the Pod Assignment button.

2. Inthe Pod Assignment dialog, drag a pod pair to the appropriate logic
analyzer.

3. Select the Close button.

To specify threshold voltages

The threshold voltage is the voltage level that a signal must cross
before the logic analyzer recognizes a change in logic levels.

1. Inthe Format tab, select the button under the pod name.

2. Inthe Pod threshold dialog, select the desired Standard or User Defined
threshoid voltage.

3. .Select the Close button.

it
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Chapter 1: Getting Started
Step 3. Format labeis for the prohed signals

To assign names to logic analyzer channels

1.

2.

Select a label button, and either:

+ Choose the Eename command, enter the label name, and select the OK
button.

* Or, choose the Insert before or Insert after cormunand, enter the label
name, and select the OK bution.

In the label row, select the button of the pod that contains the channels
you want to assign.

Either choose one of the standard label assignments--dots () mean the
channel is unassigned, asterisks (*) mean the channel is assigned--or
choose Individual.

If you chose ndividual

a. In the "label - pod® dialog, select the channels you want to assign/
unassign.

b. Belect the OK button.

Next: “Step 4. Define the trigger condition” on page 20

www.valuetronics.com
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Chapter 1: Getting Started
Step 4. Befine the trigger condition

Step 4. Define the trigger condition
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The trigger is the event in the device under test that you want to
capture data around.

1. Inthe Trigger tab, and in the Trigger Functions subtab, choose the type of
trigger you want to specify, and select the Eeplace bution.

2. Inthe Trigger Sequence portion of the Trigger tab, select the buttons to
define the label values and/or other conditions you want, to trigger on.

Next: “Step b. Run the measurement” on page 21
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Chapter 1: Getting Started
Step 5. Run the measurement

Step 5. Run the measurement
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Once the trigger condition has been defined, you can run the
measurement.

1. Select the Run Single button =

When you run a measurement, the Stop butfon becomes available while
the logic analyzer looks for the trigger condition.

Logic analyzers with deep acquisition memory take a noticeable amount of
time to complete a run; however, messages like "Waiting in level 1" may
indicate you need to stop the measurement and refine the frigger
condition.

When the trigger condition is found, logic analyzer acquisition memory is
filled, the captured data is processed to the display tools, and the Run
Single button becomes available again.

Next: “Step 6. Display the captured data” on page 22

21
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Step 6. Display the captured data

Step 6. Display the captured data
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Once vou have run a measurement and filled the logic analyzer’s
acquisition memory with captured data, you can display it with one of
the display tools.

To open Waveform or Listing displays

Waveform displays are typically used when data is captured with the
timing sampling mode, and Listing displays are used when data is
captured with the state sampling mode.

1. From the Window menu, select your logic analyzer and choose the
Waveform or Listing command.

To add display tools via the Workspace window

1. Select the Workspace button (or from the Window menu, select System
and Workspace).

2. In the Workspace window, scroll down to the Display portion of the tool
icon list.
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Chapter 1: Getting Started
Step b. Display the captured data

3. Drag the display tool icon and drop it on the analyzer icon.
4. To open the display tool, select its icon and choose the Display command.

Next: “For More Information...” on page 24
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For Maore Information...

For More Information...

On making €
measurements on the
demo counter board:

*

On connecting the .
{ogic analyzer:

On choosing the
sampling mode:

Cn formatting labels
for probed signals:

On defining the
trigger condition:

On running °
measurements:

On displaying ®
captured data:

“Example: Timing measurement on counter board” on page 26
“Example: State measurement on counter board” on page 28

Making Basic Measuremenis for a seif-paced tutorial

“Probing the Device Under Test” on page 33

Setup Assistant (see the Setup Assistant help volume) (when using
analysis probes).

Logic Analysis System and Measurement Modules Installation Guide
for probe pinowt and circuit diagrams.

“Choosing the Sampling Mode” on page 36
“The Sampling Tab” on page 115

“Formatting Labels for Logic Analyzer Probes” on page 57
“The Format Tab" on page 119

“Understanding Logic Analyzer Triggering” on page 192
“Setting Up Triggers and Running Measurements” on page 64
“The Trigger Tab” on page 146

“Running Measurements” on page 86

“Displaying Captured Data” on page 88

Using the Waveform Display Tool (see the Waveform Display Tool help
volume)

Using the Listing Display Tool (see the Listing Display Tool help volume)
Working with Markers (see the Markers help volume)

Using the Chart Display Tool (see the Chart Display Tool help volume)
Using the Distribution Display Tool (see the Distribution Display Tool

24
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Chapter 1: Getting Started
For More Information...

help volume)

¢ Using the Compare Analysis Tool (see the Compare Tool help volume)
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Example: Timing measurement on counter board

Example: Timing measurement on counter
board

This example uses the demo counter board that is supplied with the
Making Basic Measurements kit as the device under test. The kit is
supplied with every logic analysis system, or can be ordered from your
Agilent Technologies Sales Office.

To connect the logic analyzer to the device under test
1. Conrect Pod 1 of the logic analyzer to J1 on the demo counter board.

The demo counter board has built-in terminations and header connectors.

To choese the sampling mode
1. Inthe Sampling tab, choose Timing Mode.

2. Enter a sampie period of 3.0 ns.

To format labsls for the probed signals

1. Inthe Format tab, select the button under the pod 1.

2. Inthe Pod threshold dialog, select TTL; then, select the Close button.
3. Select a label button.
4

. Choose the Rename command, enter the label name "TCOUNT", and
select the OX button.

=

In the label row, select the button under pod 1.

6. Choosethe"........ kbt standard label assignment to assign the lower 8
hits of pod 1 to the "TCOUNT" label.

To define the trigger cendition

1. Inthe Trigger tab, and in the Trigger Functions subtab, choose the "Find
edge” trigger function, and select the Replace bution.

2. Inthe Trigger Sequence portion of the Trigger tab, select the Edge bution
and use the Specify Glitch/Edge dialog to specify the rising edge of bit 7
(and all ether bits as "don’t cares").

www.valuetronics.com



Chapter 1: Getting Started
Example: Timing measurement on counter beard

To run the measurement
1. Select the Run Single button.
To display the captured data

1. From the Window menu, select your logic analyzer and choose the
Waveform command.

See Also “For More Information...” on page 24

21
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Example: State measurement on counter board

Example: State measurement on counter board

This example uses the demo counter board that is supplied with the
Making Basic Measuremenis kit as the device under test. The kit is
supplied with every logic analysis system, or can be ordered from your
Agilent Technologies Sales Office.

To connect the logic analyzer to the device under test
1. Connect Pod 1 of the logic analyzer to J1 on the demo counter board.

The demo counter board has built-in terminations and header connectors.

To choose the sampling mode
1. Inthe Sampling tab, choose State Mode.

2. In the Clock Setup, using the Master only mode, specify the rising edge of
the J clock as the sampling clock.

To format labeis for the prohed signals

1. In the Format tab, select the button under the pod 1.

2. In the Pod threshold dialog, select TTL; then, select the Close button.
3. Select a label button.

4. Choose the Rename command, enter the label name *SCOUNT", and
select the OK button.

5. In the label row, select the button under pod 1.

6. Choosethe”®........ FxwwddEdt standard label assignment to assign the lower 8
bits of pod 1 to the "SCOUNT" 1abel.

To define the trigger condition

1. In the Trigger tab, and in the Trigger Functions subtab, choose the "Find
pattern n times" trigger function, and select the Replace buttor.

2. In the Trigger Sequence portion of the Trigger tab, enter "15" in the
occurrence count field, and enter enter "FX! in: the label value field.

28
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Chapter 1: Getting Started
Exampie: State measarement on counter board

To run the measurement

1. Select the Run Single button.

Te display the captured data

1. From the Window menu, select your logic analyzer and choose the Listing
command.

See Also “For More Information...” on page 24

29
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Example: State measursment on counter board
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Task Guide

s  “Probing the Device Under Test” on page 33
¢ “Choosing the Sampling Mode” on page 36
¢ “Selecting the Timing Mode (Asynchronous Sampling)” on page 36

www.valuetronics.com
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Chapter 2: Task Guide

* “Selecting the State Mode (Synchronous Sampling)” on page 43
+  “In Either Timing Mode or State Mode” on page 52
+ “Using 2 GHz Timing Zoom” on page 54
¢« “Formatting Labels for Logic Analyzer Probes” on page 57
¢ “Setting Up Triggers and Running Measurements” on page 64
e “Using Trigger Functions” on page 65
e “Using State Mode Trigger Features” on page 70
« “Editing the Trigger ‘Sequence” on page 72
e “Editing Advanced Trigger Functions” on page 77
e “Saving/Recalling Trigger Setups” on page 84
e “Running Measurements” on page 86
s “Displaying Captured Data” on pagé 88
e  “Using Symbols” on page 95
s “Printing/Exporting Captured Data” on page 104
¢ “Cross-Triggering” on page 106
¢ “Solving Logic Analysis Problems” on page 108
e “Saving and Loading Logic Analyzer Configurations” on page 110

See Alse Measurement Examples (see the Measurement Examples help volume)

32
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Prohing the Device Under Test

Probing the Device Under Test

The figures below shows a variety of simple probing connections. The
specific probe type, number of probes, and location on the device
under test circuit depends on your particular measurement.

For equivalent circuit diagrams and pinouts, see the description of the
probe type in the Logic Analysis System and Measurement Modules
Installation Guide. If you have misplaced the Logic Analysis System
and Measurement Modules Installation Guide, you can download
the latest version from the world-wide web at:

httpArwww.cos.agilent.cormm/manuals/logic analyzers.hitml#la 16700b

Probe Lead-to-Board
Connection

The standard lead set plugs directly into any .1-inch grid with 0.026 to
(0.033-inch diameter round pins or 0.025-inch square pins. All probe
tips work with the Agilent Technologies 5059-4356 surface mount
grabbers and the Agilent Technologies 5959-0288 through-hole
grabbers.
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Probing the Device Under Test

Adapter-to-Board
Connection _ o T

Prcﬁe Gahle

I '{;Tarminaﬁoh Adapter .
i 1 BE0-8E200 :

- ¢ High-Density’
{ Termiration
Adapter
ES346A

Both the 01650-63203 and the Eb346A adapters inclunde termination
for the logic analyzer. The 01650-63203 termination adapter plugs into
a 2 x 10 pin header with 0.1 inch spacing. The E5346A high-density
adapter connects to an AMP "Mictor 38" connector. If possible, use
support shrouds around the Mictor connector to relieve strain and
improve connections.

Direct Pod-to-Beard  If you provide proper termination as part of the device under test

Connection board, you can phag the pod directly into the ©3M 2520-series, or
similar alternative connector. Suggested termination is shown in the
Logic Analysis System and Measurement Modules Installation
Guide.

Also use this termination with the Agilent Technologies E5351A high-
dengity, non-terminated adapter.

Pod-to-Analysis Analysis probes {formerly called preprocessors) are microprocessor-

Probe Connection  gpecific interfaces that make it easier to probe buses. Generally,
analysis probes consist of a circuit board that attaches to the
microprocessor (possibly through an adapter) and a configuration file.
The configuration file sets up the logic analyzer's clocks and labels

34
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Chapter 2: Task Guide
Probing the Device Under Test

correctly, and may include an inverse assembler. The circuit board
provides access to logical groups of pins through headers designed to
connect directly to the logic analyzer.

The easiest way to set up a measurement with an analysis probe is the
Setup Assistant (see the Sefup Assistant help volume). The Setup
Assistant asks you questions about your measurement and then shows
you just the information you need to set up the probe correctly. It also
loads the proper configuration files.

See Also hitp:/fwww.agilent.com/find/Laaccessories/ for more information on
Agilent logic analyzer probing accessories.

K]
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Choosing the Sampling Mode

Choosing the Sampling Mode
There are two logic analyzer sampling modes to choose from: timing
mode and state mode.

In timing mode, the logic analyzer samples asynchronously, based on
an internal sampling clock signal.

In state mode, the logic analyzer samples synchronously, based on a
sampling clock signal (or signals) from the device under test. Typically,
the signal used for sampling in state mode is a state machine or
microprocessor clock signal.

e “Selecting the Timing Mode (Asynchronous Sampling)” on page 36
¢+ “Selecting the State Mode (Synchronous Sampling)” on page 43

¢ “In Either Timing Mode or State Mode” on page 52

o  “Using 2 GHz Timing Zoom” on page b4

Selecting the Timing Mode (Asynchronous

Sampling)

In temmimg mode, the logic analyzer samples asynchronously, based on
an internal sampling clock signal.

* “To select the timing mode” on page 40

*  “To select the full/half channel configuration” on page 41

s “Tp select transitional timing or store qualified” on page 37

» “To specify the sample period” on page 42

36
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To select transitional timing or store qualified

To select transitional timing or store qualified

1. Inthe Sampling tab with Timing Mode selected, select the Transitional
Timing with Store Qualification configuration.

Transiticnal Timing

In Conventional Timing Acquisition mode, the analyzer stores
measurement data at each sampling interval. In Transitional Timing
Acquisition mode, the timing analyzer samples data at regular intervals,
but only stores data when there is a threshold level transition. Each
time a level transition occurs on any of the bits, data on all channels is
stored. A time tag is stored with each stored data sample so the
measurement can be reconstructed and displayed lafer.

NOTE: Transitional timing or store gualified timing, requires time tags to recreate the
data. Time tags are stored in either a dedicated tag chip, if an vnused data pod
exists, or are interleaved with the data in memory, If tags are interleaved with
the data, available memory depth is reduced by half.

Store Qualified Timing

Store qualified timing allows you to specify what data is stored during
the course of an acquisition. The level of data qualification can be
simple (Store Anything or Store Nothing), or more complex {Custom).

For information on setting up store qualification, refer to To specify
default storing (see page 70)

See Aiso
“More on Storing Transitions” on page 38
“Transitional Timing Considerations” on page 39
“Default Storing Subtab” on page 156

37
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To select ransitional timing or store qualified

More on Store Qualification in Transitional
Timing

When Transitions is selected on the Default Storing subtab, the
defaulf store qualification is setup to store data on all channels if an
edge/transition occurs on any one channel. Only active channels
{channels assigned to labels) are used. No further user action is
required.

If certain channels have a high occurrence of transitions that are
meaningless in the context of the measurement, they can be ignored
with the following procedure.

1. Select Select Labels.

2. From the Tramsitions Label Select dialog that appears, highlight the
desired label from the Available Labels list, then select the right-arrow to
move the selection to the Ignore Edges On list.

3. Repeat as needed for additional labels.

4, Select OK to save the selection and close the dialog. Selecting Cancel, will
undo any changes and close the dialog.

Unlike the Custom default storing mode, when Transitions is
selected, no other qualifier events like patterns, ranges, etc., are
available. Also, storing cannot be enabled or disabled in the sequence
branch action lists.

NOTE: K you have a bit that is shared across multiple labels, all labels containing that
bit must be on the Ignore list before transitions on that bit will no longer cause
a sample to be stored.

More on Storing Transitions

Minimum Transitions Stored

Normally, transitions have not occurred at each sample period. This is
illustrated below with time-tags 2, b, 7, and 14. When transitions
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happen at this rate, two samples are stored (four at the fastest rate of
2.5 ns) for every transition. Therefore, with 2 K samples of memory, 1
K of transitions are stored. You must subtract one, which is necessary
for a starting point, for a minimnum of 10283 stored transitions.

Maximum Transitions Stored

If transitions occur at a fast rate, such that there is a transition at each
sample point, only one sample is stored for each transition as shown by
time tags 17 through 21 below. If this continues for the entire trace, the
number of transitions stored is 2 K samples. Again, you must subtract

the starting point sample, which then yields a maximum of 2047 stored

transitions.
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In most cases a transitional timing trace is stored by a mixture of the
minimum and maximum cases. Therefore, in this example the actual
number of transitions stored will be between 1023 and 2047.

Transitional Timing Considerations

Data Storage

When an edge is detected, two samples (four when sampling at 2.5 ns)
are stored across all channels assigned to the timing analyzer. The need
of two samples is to avoid loss of data if a second edge were to oceur to
soon after the first edge for the edge detectors to reset.

K
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Sequence fevel branching

In transitional timing, only 2 branches are available per sequence level,

Global counters

In transitional timing, only one global counter is available.

Storing Time Tags

Transitional timing requires time tags to recreate the data. Time tags
are stored in either a dedicated tag chip, if a spare pod exists, or are
interleaved with the data in memory. If tags are interleaved in data,
available memory depth is reduced by half,

Increasing Duration of Storage

Using the Transitional Label Select dialog to specify selected labels to
ignore can increase usable memory depth and acquisition time by
ignoring transitions on signals like clock or strobe that add little useful
information to the measurement when no other signals are
transitioning.

invalid Data

The analyzer only looks for transitions on data lines on labels that are
turned on. Data lines on labels that are turned off store data, but only
when one of the lines that is turned on transitions. If the datalineon a
label is turned on after a run, or the data line is assigned to a new label,
yvou would see data, but it is unlikely that every transition that occurred
was captured.

Trigger Position

In transitional timing, no data prestore {samples acquired before
trigger) is required. Therefore, much like state mode, the frigger
position (start/center/end) will indicate the percentage of memory
filled with samples after the trigger. The number of sampies acquired/
displayed before trigger will vary between measurements.

To select the timing mode
1. Open the logie analyzer Setup window,

4
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2, Select the Sampling tab.

3. Choose the Timing Mode option.

You can also select the timing sampling mode in the “Pod Assignment
Dialog” on page 130.

To select the full/half channel configuration

1. Inthe Sampling tab, with Timing Mode selected, select the timing analyzer
configuration. You can choose between:

¢ 2M Sample Full Channel 333 MHz

In this configuration, the total memory depth is 2M samples per
channel, with data being sampled and stored as often as every 3.0 ns.
You can set the sample rate to go slower with the Sample Period
control.

NOTE: When the Sample Period is 3.0 ns, data is acquired at two times the trigger
sequencer rate. This means that data must be present for at least two samples
before the trigger sequencer can reliably detect ii. The trigger sequencer
could miss data present for less than two sample periods,

The trigger sequencer treats the data as a group of two samples for each
sequencer clock. This means that the trigger point indication could be off by
one sample.

Although the trigger sequencer cannot detect all data, the analyzer will
correctly capture all data present for at least one sample period.

¢ 4M Sample Half Channel 667 MHz

In this configuration, only one pod of each pod pair is available.
Channels assigned to unavailable pods are ignored. You can specify
which pod to use by toggling the Pod field in Format.

The total memory depth is 4M samples per channel. Data is sampled
and stored every 1.5 ns; this rate cannot be changed.

L3
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NOTE: When the Sampie Period is 1.5 ns, data is acquired at four times the trigger
sequencer rate. This, along with other half-channel mode characteristics,
means that data must be present for at least five samples before the trigger
sequencer can reliably detect if. The trigger sequencer cannot detect data
present for less than two sample periods, and could miss data present for less
than five sample periods,

The trigger sequencer treats the data as a group of four samples for each
sequencer clock. This means that the trigger point indication could be off by
up to three samples.

Although the trigger sequencer cannot detect all data, the analyzer will
correctly capture all data present for at least one sample period.

2. If you chose the 667 MHz Half Charnel $M Sample configuration, select
the Format tab and choose which pod of the pod pair wilt be used fo
sampile data.

See Aisc “To specify the sample period” on page 42

To specify the sample period

When the logic analyzer is in timing (asynchronous sampling) mode,
the Sample Period setting specifies how often the logic analyzer
samples the signals from the device under test.

1. In the Sampling tab, with Timing Mode selected, enfer the desired fime
between logic analyzer samples.

To capture signal level changes reliably, the sample period should be less
than half (many engineers prefer one-fourth) of the period of the fastest
signal you want to measure.

The sample rate is the inverse of the sample period.

NOTE: In conventional timing mode the sample rate is fixed at 1.25 ns.
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Selecting the State Mode (Synchronous
Sampling)

In state mode, the logic analyzer samples synchronously, based on a
sarnpling clock signal (or signals) from the device under test. Typically,
the signal used for sampling in state mode is a state machine or
microprocessor clock signal.

e “To select the state mode” on page 44

e “To select the 167 MHz/333 MHz state speed configuration” on page 44
¢ “Tg change the sampling clock mode” on page 44

» “To set up the sampling clock” on page 46

Stat_e_Mnde Sampling In order for a state mode logic analyzer to accurately capture data from
Position a device under test, the logic analyzer’s setup/hold time (window) must
fit within the device under test’s data valid window.

Because the location of the data valid window relative to the bus clock
is different for different types of buses, the logic analyzer lets you
adjust the sampling position in order to accurately capture data on
high-speed buses (see “Understanding State Mode Sampling Positions”
on page 208),

When the device under test's data valid window is less than 2.5 ns
(roughly, for clock speeds >= 200 MHz), it's easiest to use eye finder
to locate the stable and transitioning regions of signals and to
automatically adjust sampling positions.

= “To automatically adjust sampling positions” on page 47

When the device under test’s data valid window is greater than 2.5 ns
(roughly, for clock speeds < 200 MHz), it's easiest to adjust the
sampling position manually, without using the logic analyzer to locate
the stable and {ransitioning regions of signals.

» “To manually adjust sampling positions” on page B0
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To select the state mode

1. Open the logic analyzer Setup window.

2. Select the Sampling tab.

3. Choose the State Mode option.

You can also select the state sampling mode in the “Pod Assignment
Dialog” on page 130.

To select the 167 MHz/333 MHz state speed configuration

1. Inthe Sampling tab, with State Mode selected, select the state analyzer
configuration. You can choose between:

e 167 MHz/2M State
In this configuration, all pods are available,

Memory depth is 2M samples per channel. I time or state count is
turned on in Trigger Settings, the total memory is split between data
acquisition storage and time or state cournt storage. To maintain the full
mermory depth of 2M samples per channel, leave one pod pair
unassigned. (To unassign a pod pair, select the Pod Assignmend button
in the Format tab, then drag a pod pair to unassigned.)

State clock speed matches vour device under test's clock, up to 167
MHz.

e 333 MHz / 2M State

This configuration is similar to the 167 MHz State mode, except
clocking is restricted to the J clock on Pod 1 of the master card of the
module, and triggering is restricted to two trigger functions.

NOTE: When Store Qualification is performed in the 333 MHz State mode, there may
be the case where data occupying memory is further disqualified. As a result,
you may see a non-contiguous listing of states as well as a reduction of usable
IMEINory.

To change the sampling clock mode

Normally, in the Master only sampling clock mode, there is one
sampling clock signal. When a clock edge occurs, data is captured and
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saved into ene sample of logic analyzer memory.
Two additional sampling clock modes let you capture data differently:

e In the Master/Siave mode, you can save data captured on different clock
edges into the same sample of logic analyzer memory.

Analyzer Memory 4— Masier

Clock
t t

Slave Latch — Slave
Clock

Pod3 Pod4
Podt Pod2 Slave Slave

Master Master

When the slave clock ocecurs, data captured on the pods that use the slave
clock is saved in a slave latch. Then, when the master clock oecurs, data
captured on the pods that use the master clock, as well as the slave latch
data, are saved into logic analyzer memory.

¢ In the Demultiplexr mode, you can demultiplex data being probed by one
pod into the logic analyzer memory that is normally used for two pods.

Analyzer Memory —— giisctlfr

lave Latch e Slave
‘f Clock

Fod1 {ped 2 s not connected)

When the slave clock occurs, data captured on the pod is saved into the
slave latch for the other pod in the pod paiv. Then, when the magter clock
occurs, data captured on the pod, as well as the slave latch data, are saved
in logic analyzer memory.

To set up the master sampling clock mode

1. Inthe Sampling tab, with State Mode selected, select the Master only
mode in the Clock Setup area.
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To set up the master/slave sampling ciock mode

1. Inthe Sampling tab, with State Mode selected, select the Master/Slave
mode in the Clock Setup area.

2. Inthe Format tab, select Siave Clock for each pod that should use the
slave clock, and select Master Clk for each pod that should use the master
clock.

To set up the demultiplex sampling elock mode

1. Inthe Sampling tab, with State Mode selected, select the Demulliplex
mode in the Clock Setup area.

2. Inthe Format tab, select Demudtiplex for the pod pair that should use this
mode.
To set up the sampling clock

1. Inthe Sampling tab, with the State Mode selected, make sure the
Advanced Clocking box is unchecked.

2. For each clock input signal that will be used:
a. Select the pod’s Master or Slave button (under the activity indicator),

b. I the signal edge will specify when to sample, choose Rising Edge,
Falling Edge, or Both Edges.

¢. M the signal level will enable the sampling clock, choose Qualifier -
High or Qualifier - Low.

3. Make sure all unused clock inputs are turned Off.

To set up using advanced ctocking

1. In the Sampling tab, with the State Mode selected, select the Advanced
Clocking check box,

2. Select the Master Clock button. In the Master clock dialog, select the
appropriate options for setting up the master clock.

3. Hyou have chosen the Master/Slave or Demultiptex clock mode, select the
Slave Clock button. In the Slave clock dialog, select the appropriate
options for setting up the slave clock.

www.valuetronics.com



Chapter 2: Task Guide
To select transiticnal timing ar store gualified

See Also *“To change the sampling clock mode” on page 44

To automatically adjust sampling positions

When adjusting the state mode sampling position with eye finder, the
logic analyzer looks at signals from the device under test, figures out
the location of the data valid window in relation to the sampling clock,
and automatically sets the sampling position.

Because eye finder automatically runs on individual channels, it can
correct for the small delay effects caused by probe cables and circuit
board traces. This makes the logic analyzer's setup/hold window
smaller and lefs you accurately capture data at higher clock speeds.

Eye finder requires:

¢ At least 500 transitions on each signal during its run. (You can use the
advanced eye finder settings to cause longer or shorter runs.)

¢ All devices which can drive each signal should contribute to the stimulus.

¢ All device under test operating modes relevant to the eventual logic
analysis measurement should contribute to the stimutus as well.

NOTE: Eye finder measurements and normal logic analyzer measurements cannot
run simuitaneously.

NOTE: Eye finder does not support the Master/Slave or Demultiplex sampling clock”
modes.

To run eye finder
1. Probe the device under test by connecting the logic analyzer channels.

2. Select the state (synchronous sampling) mode {see “To select the state
mode” on page 44).

3. Format labels for those logic analyzer channels.

4. Make sure that the device under test and the logic analyzer have warmed
up to their normal operating temperatures.

5. In the Format tab, select the Setup/Hold button.
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6. In the Sampling Positions dialog, select the Bye Finder option.

7. Inthe Eye Finder Setup tab, select the Use ségnals from Device Under
Test option.

The Use demo data (mo probes reguired) option is for demonstration
purposes only.

8. Choose the labels that you wish to run eye finder on.

You may want to run eye finder on channel subsets, for example, when
certain bus signals transition in one operating mode (of the device under
test) and other bus signals transition in a different operating mode.

9. Select the Run Eye Finder button.

For more information on run messages, see “Eye Finder Run Messages” on
page 136,

When eye finder finds more than one stable region on a channel, it uses
the current sampling position as a hint about which stable region it should
suggest a position for,

If eye finder picks the wrong stable region, you can expand the label and
drag the blue Sampling Position line into the correct stable region. The
suggested samphling position for that region will be shown (see “How
Selected/Suggested Positions Behave” on page 135),

10. If you have moved the sampling position and wish to return to the
suggested positions, go to the Eye Finder Results tab, select a Iabel button
or the Results menu, and choose the *set fo suggested" command.

For more information on informational messages in the Eye Finder Results
tab, see “Eye Finder Info Messages” on page 139.

Eye finder finds optimal sampling positions for the actual specific
conditions — amplitude, offset, slew rates, and ambient temperature.
Therefore, you will get the best results by running eye finder under
the same conditions that will be present when logic analysis
measurements are made.

To run eye finder repetitively
1. Select the Repetitive Run option in the Eye Finder Setup tab.
2. Select the Run Eye Finder () button.
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In the Eye Finder Results tab, you can see how the stable and transitioning
areas vary over time.

3. Select the Stop Eye Finder button.

To view eye finderdata as a bus composite
When you want a compressed, high-level view of the eye finder data:

1. Inthe Eye Finder Results tab, select the label button and choose the View
as Bus Composite command.

“Ege Finder Setup

:.;L‘abél_l- {16 channeia}é L )

Average sampling positions as well as stable and transitioning areas are
displayed for the whole label. This is the default. Stable areas show
positions where every channel in the label is stable.

To view eye finderdata as a stack of channels
When you want more resolution in your view of the eye finder data:

1. Inthe Eye Finder Results tab, select the label button and choose the View
as Stack of Chanrels command.

Individual sampling positions and stable and transitioning areas for all the
channels in a label are shown.

To save/load eye finder data

While the eye finder sampling positions are saved with the logic
analyzer configuration, eye finder measurement data is not; therefore,
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eye finder data must be saved and loaded separately.
1. Inthe File Info tab, select the Save As... or Load... buttons,

You can also choose the Save Fye Finder or Load Fye Finder command
from the File menu.

2. Inthe file browser dialog, name the file to be saved or select the file to be
loaded.

For more information on save/ioad messages, see “Eye Finder Load/Save
Messages”™ on page 141.

See Alse “Understanding State Mode Sampling Positions” on page 208
“Eye Finder Advanced Settings Dialog” on page 133
“To manually adjust sampling positions” on page 50

To manually adjust sampling positions

To use the Eye Finder option

Although the F'ye Finder option was intended for automatically
adjusting state mode sampling positions, you can also use it to
manually adjust sampling positions. You don't have to Run Eye Finder
to locate stable and transitioning regions on signals, just go directly to
the Eye Finder Results tab, and drag the sampling positions to the
proper locations.

1. Select the state (synchronous sampling) mode (see “To select the state
mode” on page 44).

2. Inthe Format tab, select the Setup/Hold button,
3. In the Sampling Positions dialog, select the Fye Finder option.

4. Inthe Eye Finder Results tab, drag the sampling positions to the proper
locations.

You can select bus labels to expand or collapse the channels in the iabel.

When using the Eye Finder option to manually adiust state mode
sampling positions, the sampling positions are saved with the logic
analyzer configuration (see “Saving and Loading Logic Analyzer
Configurations” on page 110}.
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1o use the Manual Setup/Hold eption

When adjusting the state mode sampling position with the Manual
Setup/Hold option, you adjust the logic analyzer’s setup/hold window
relative to the sampling clock signal from the device under test. The
setup time is the front edge of the setup/hold window relative to the
sampling clock, and the hold time is the back edge of the setup/hold
window relative to the sampling clock.

1. Select the state (synchronous sampling) mode (see “To select the state
mode” on page 44).

2. Inthe Format tab, select the Setup/Hold button.
3. Inthe Sampling Positions dialog, select the Manual Setup/Hold option.

4. For each label, enter setup/hold values. The values are adiustable in 100 ps
increments, with a fixed window of 2.5 ns.

5. I youneed to adjust bits individually:
a. Select a label containing the bit.

If a bit is used in more than one label, you will change its setup and
hold value in gll labels.

b. Select the ndividual bits option.

¢. Enter the bit number you want to change.

d. Enter the setup/hold value.
6. Close the Sammpling Positions dialog,
The Manual Setup/Hold sampling position's are saved and loaded along
with the logic analyzer configuration file.

Example Suppose you're probing a bus in the device under test whose data valid
window is 3 ns. Suppose also that the bus clock edge occurs 1 ns into
the data valid window. To place the logic analyzer’s setup/hold window
within the data valid window, you could specify a setup value of 800 ps
{and hold value of 1.7 ns).
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{The actual sampling position is in the middle of the setup/hold
window.)

See Also “Understanding State Mode Sampling Positions” on page 208

“To automatically adjust sampling positions” on page 47

In Either Timing Mode or State Mode

* “To specify the trigger position” on page b2
e« “To set acquisition memory depth” on page 53
e “Toname an analyzer” on page 53

e “To turn an analyzer off or on” on page 53

To specify the trigger position

1. Inthe Sampling tab {or in the Seitings subtab of the Trigger tab), select
the trigger position.

Specify whether you want to look at data after the trigger (Start}, before
and after the trigger {Center}, before the trigger (End), or use a
percentage of the logic analyzer's memory for data after the trigger (User
Defined).

In Conventional Timing Mode, when a Run is started, the analyzer will
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not look for a trigger until the specified percentage of pretrigger data
has been stored. After a trigger has been detected, the specified
percentage of posttrigger data is stored before the analyzer halts,

In State and Transitional Store Qualified modes, when a Run is started,
the analyzer immediately looks for the trigger condition. In other
words, the trigger position setting specifies the maximum amount of
data that should be stored before the trigger.

To set acquisition memory depth

If you need less data and want measurements to run faster, you can
limit the number of samples that are stored in logic analyzer acquisition
NEMOTY.

1. In the Sampling tab (or in the Settings subtab of the Trigger tab), select
the acquisition depth.

The number of samples that can be chosen for the Acquisition Depth are
approximations. The combination of count tags, pod assignments, and
configuration modes affect what choices are available.

To name an analyzer

You can give more descriptive names to a logic analyzer.

1. Inthe Sampling tab, select the Analyzer Name field.

2. Enter the new name.
The name now appears below the instrument tool icon in the workspace.

You can also name analyzers in the “Pod Assignment Dialog” on

page 130.

To turn an analyzer off or on

You may want to turn an analyzer off if you don't want it to be included
in further measurements.

Jo turn an analyzer off

1. In the Sampling tab, select the Ox box that is checked,
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2. Inthe Analyzer Shutdown Options dialog, choose either:

e Soft -~ This will leave the logic analyzer window but turn off most
options.

¢« Hard - This will remove the logic analyzer and its display tools from
the Workspace.

You can also turn an analyzer off in the “Pod Assignment Dialog” on
page 130.

To turn an analyzer back on

1. If you used the Soft option when turning the logic analyzer off, you can
turn it on again by selecting the Off check box.

2. If you used the Hard option when turning the logic analyzer off, you can
turn it on again by selecting the Setup button in the System window or by
dragging the analyzer’s instrument tool icon to the workspace in the
Workspace window.

Using 2 GHz Timing Zoom

Timing Zoom collects additional high-speed timing data around the
trigger of the logic analyzer. It uses a 16K-sample, 2 GHz timing
analyzer to sampie data as closely as every 500 ps on all channels.

The Timing Zoom settings are accessed through the Timing Zoom
button under Sampling.

*  “To turn Timing Zoom on or off” on page 54

¢ “To set the Timing Zoom trigger position” on page 55

e “To gpecify which analyzer has Timing Zoom” on page 56
s “Tp set the Timing Zoom sample period” on page 56

To turn Timing Zoom on or off

If you are not interested in the Timing Zoom data for a measurement,
vou can turn off Timing Zoom and improve logic analyzer performance.
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1. Inthe Sampling tab, select the Timing Zoom button,
2. Inthe Timing Zoom controls dialog, select the On/Off checkbox.

To set the Timing Zoom trigger position
1. Inthe Sampling tab, select the Timing Zoom buttorn.
2. Inthe Timing Zoom controls dialog, select the trigger position.

Specify whether you want to look at Timing Zoom data after the trigger
(Start), before and after the trigger (Center), before the trigger (End), or
use a percentage of the logic analyzer's memory for data after the trigger
{(User Defined).

NOTE: When in 3883 MHz Siate mode (16717,18,19) or the 400 MHz State mode
{16750,61,52), the start of Timing Zoom data may occur after the actual
trigger point. The reason for this data mis-alignment is due to how the frigger
sequencer functions when in Turbo State mode.

The analyzer sequencer works on Pairs of samples. It will not evaluate the
first sample of the pair until the second sample has entered the sequencer. If
for example the trigger point is determined to be on the first sample, the
analyzer displays the Timing Zoom data relative to the evaluation of the
second sample. What ever time difference is seen between the two samples
{of the pair} is reflected in the data display between the trigger point and the
start of the Timing Zoom data.

This time difference can be noticeable if your measurement is using bursted
clocks and the first sampie {actual trigger point) is clocked on the last clock
signal of a burst, and the second sample (of the pair) is clocked with the first
clock of the next burst. The time difference between the clock bursts is
reflected as a mis-alignment between the trigger point and the start of the
Timing Zoom data.

The best thing to do to help mitigate this situation is to set the Timing Zoom to
"Trigger Position End" to capture as much data near the first sample as
possible.
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To specify which analyzer has Timing Zoom

NOTE: I you have both analyzers of the module turned on, youneed to specify which
analyzer you want to use Timing Zoom with.

1. Inthe Sampling tab, select the Timing Zoom button.

2. Inthe Timing Zoom controls dialog, select the analyzer that Timing Zoom
will work with.

To set the Timing Zoom sample period

If you want to see more or less sampling resolution arcund the trigger,
you can adjust the Timing Zoom sample period.

1. In the Sampling tab, select the Timing Zoom button,
2. Inthe Timing Zoom controls dialog, select the sample period.
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Formatting Labels for Logic Analyzer Probes

The Format tab is mainly for assigning bus and signal names (from the
device under test), to logic analyzer channels. These names are called
labels. Labels are used when setting up triggers and displaying
captured data.

The Format tab also lets you do things like assign pod pairs to one or
two logic analyzers, specify the logic analyzer threshold voltage,
change the label polarity, reorder bits in a label, and turn labels off or
on.

The Format tab has activity indicators that show signal levels.
¢ “To assign pods to one or two analyzers” on page 57

* “To set pod threshold voltages” on page 58

¢ “To assign probe channels to labels” on page 59

¢ “To change the label polarity” on page 61

¢ “To reorder bits in a label” on page 61

¢ “To turn labels off or on” on page 62

To assign pods to one or two analyzers

A logic analyzer’s pod pairs can be assigned to one or two separate
logic analyzers or they can be left unassigned.

1. Inthe Format tab, select the Pod Assignment button.

2. Inthe Pod Assignment dialog, drag a pod pair to the appropriate logic
analyzer.

3. Select the Close button.

When all pods are assigned and state or time counts are saved with the
captured data, logic analyzer acquisition memory is halved to 1M
samples,
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When using a multi-card logic analyzer:

¢  When both analyzers are turned on, pods 1/2 and 3/4 of the master card
cannot be agsigned fo the same analyzer.

¢ Fach pod pair has two clock channels, but only the clock channels of
pods on the master card can be used in the analyzer's clocking setup.
(The master card’s pods needn't be assigned in order to use their clock
channels).

To turn on an analyzer that is off
1. Select Off and choose State or Timing.
(Only one analyzer at a time can be set to Timing.)
A second analyzer window appears after a pause for setup.

You can also turn on an analyzer that is off by opening the Workspace
window and dragging the instrument tool icon onto the workspace.

See Also “Pod Assignment Dialog” on page 130

To set pod threshold voltages

The threshold voltage is the voltage level that a signal must cross
before the logic analyzer recognizes a change in logic levels. In addition
to a user defined choice, you can also select a predefined level from the
standard choices.

Standard

1. Inthe Format tab, select the threshold button located just below the pod
name.

2. In the Pod threshold dialog, choose one of the standard threshold options:
¢ TTL -- The threshold level is +1.50 volts.
e LVTTL -~ The threshold level is +1.40 volts.
®  SSTL2 - The threshold level is +1.50 volts.
* SSTLS3 - The threshold level is +1.25 volts.
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¢ LVCMOS 1.5v - The threshold level is +0.75 volts.
¢ LVCMOS 1.8v — The threshold level is +0.50 volts.
¢ LVCMOS 2.5v - The threshold level is +1.25 volts.
¢  LVCMOS 3.3v — The threshold level is +1.65 volts.
¢ CMOS 5.0v -- The threshold level is +2.50 volts.

¢ ECL -- The threshold level is -1.3 volts,

¢ LVPECL -- The threshold level is 2.00 volts.

3. Ifyou don't want the change to apply to all pods, deselect the checked box
next to Apply settings to all pods.

4. Select the Close button.

User Defined

When User Defined is selected, the threshold level is selectable from -
6.0 volts to +6.0 volts.

NOTE: The logic analyzer requires a minimum voltage swing of 500 mV at the probe
tip to recognize changes in logic levels.

NOTE: The threshold voltage specified also appHes to the pod's clock input.

To assign probe channels to labels

The logic analyzer lets you assign names (labels) to logic analyzer
channels so that it’s easier to set up triggers and interpret the captured
data when digplayed,

Typically, you give labels the names of the buses and signals in the
device under test that are are being probed.

1. In the Format tab, select a label button, and either:

# Choose the Rename command, enter the Iabel name, and select the OK
button.

B9
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e QOr, choose the Insert bgfore or Insert afier command, enter the label
name, and select the OK button.

2. In the label row, select the button of the pod that contains the channels
you want to assign.

3. Either choose one of the standard label assignments or choose
Individual.

{*) (asterisk) indicates an asgigned bit,

(. ) {(period} indicates an unassigned bit.

{ R ) indicates an assigned bit in a recordered label.
If you chose ndividual:

a. In the "label - pod” dialog, select the channels you want to assign/
unassign.

b. Select the OK button.
A maximum of 32 channels can be assigned to a label.

In the Format tab, least significant pod channels (bit 0) are on the right
and most significant pod channels (bit 15) are on the left. (The bit
numbers are shown just below the activity indicators.)

Labels can contain bits that are not consecutive; however, bits are
always numbered consecutively within a label,

A label can include data and clock channels from more than one ped,
but this places restrictions on the complexity of the trigger later.

To delete lahels
1. Select the label name that you want to delete.
2. Choose Delete.

If only one label is defined, it cannot be deleted.

When you delete labels, their bit assignments are not saved. However,
you can make a label inactive and save its bit assignments by turning
the label off.

See Also “To reorder bits in a label” on page 61
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“To turn labels off or on” on page 62

“To change the label polarity” on page 61

To change the label polarity

While negative logic is rare in circuits (the main exception at this time
is RAMBUS), you can change the label polarity if the device under test
uses negative logic.

1. Inthe Format tab, select the polarity button (next to the label button) to
toggie between positive (+) and negative (-) polarity.

Positive polarity means that a high voltage is a logic "1%.
Negative polarity means that a high voltage is a logic "0".
Changing the label polarity will have the following effects:

e "1" and *0" values flip in the trigger condition.

¢+  Waveforms and bus values (where shown) invert in the Waveform display
tool. '

e "1"and "0" values flip in the Listing display tool.
Changing the label polarity does not affect:

« Hdge definitions for clock setup and edge terms.
¢ Symbol definitions for the logic analyzer.

¢ Activity indicators.

To reorder bits in a label

In cases where buses in the device under test haven’t been probed with
consecutive logic analyzer channels, you can reorder the bits in a label.

1. Inthe Format tab, select the label button whose bits you want to reorder.

2. Choose Reorder bits.

1
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3. In the Change Bit Order dialog:

s To reorder the bits individually, enter the bit that the probe channel
should be mapped to.

« To swap the high and low order bytes or words, select the button Big
Endian to Litile Endian at the bottom of the dialog.

s o return to sequentially ordered bits, select the button Default Order
at the bottom of the dialog,

4. Select the OK button.

The label now shows an "R" to indicate that the assigned bit has been
reorderad.

NOTE: Labels with reordered bits cannot be used as range terms or <, <=,>, >=In
triggers.

To turn labels off or on

When you temporarily want to remove a label and its data, you can turn
off the label. The label name and its bit assignments are preserved.

To turn a lahel off
1. Inthe Format tab, select the label button that vou want to turn off.
2. Choose Label [ON] to toggle it off,

At least one label must remain on,

To turn a label on
1. Inthe Format tab, select the label button that you want to turn on.,

2. Choose Label [OFF] to toggle it on.

To display a Iabel that was off
1. Turn on the label.
2. Af the bottom of the window, select the Apply button.

62
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The label’s data appears in the display windows.
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Setting Up Triggers and Running Measurements

The following information is a generic discussion about triggering in
logic analyzers. Depending on the logic analyzer type, and the state or
timing mode being used, some functionality may not be available.

s “Using Trigger Functions” on page 65

e “Using State Mode Trigger Features” on page 70
« “liditing the Trigger Sequence” on page 72

o “Hditing Advanced Trigger Functions” on page 77
o “Saving/Recalling Trigger Setups” on page 84

¢ “‘Running Measurements” on page 86

Use trigger functions for basic measurements.

For more complicated measurements, where no trigger function exists,
start with a trigger function that’s similar to the measurement you want
to make. Then, break down the trigger function and edif the advanced
trigger sequence levels.

Everything that looks like a button in the trigger definition gives you a
way to modify the trigger setup.

For example, to look for a edge instead of a pattern, select the button
that equates a label with a pattern and choose an edge comparison
instead.

For every state analysis sample, a logic analyzer needs to know two
things:
1. Should some action (like a trigger) be taken as a result of this sample?

2. What should be done with this sample? That is, should it be stored in logic
analyzer memory or should it be discarded? (This guestion doesn't need to
be asked when using a timing analyzer because all samples are stored.)

State analysis trigger definitions are made simpler with a defawlt
storage qualifier. This makes it possible to ignore, at all trigger

64
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sequence levels, the question about what to do with the captured data
samples.

Of course, sometimes it’s useful to specify storage qualifiers at certain
levels in the trigger sequence. For this, you can insert storage actions
in the trigger sequence before trigger or goto actions. Storage actions
in the trigger sequence override the default storage qualifier for the
samples that cause the trigger or goto actions to occur. Storage actions
can also be used to turn on or off the default storing.

Using Trigger Functions

Many common measurement setups are provided with the logic
analyzer. These setups are called trigger functions, and you can use
thern for quick measurement setup.

For more complicated measurements, where no trigger function exists,
start with a trigger function that’s similar to the measurement you want
to make. Then, break down the trigger function and edit the advanced
trigger specification.

NOTE: In the 16760 logic analyzer, you cannot break down trigger functions in the
400, 800, and 1250 State modes.

e “To select a trigger function” on page 65

¢ “To specify a label pattern event” on page 66

¢ “To specify a label edge event” on page 67

*  “To break down a frigger function” on page 67

¢ “To create a trigger function library” on page 68

To select a trigger function

1. Inthe Trigger tab's Trigger Functions subtab, select the appropriate
trigger function.

A picture describing the trigger function is shown.
2. Select the Eeplace button {or Insert before or Insert after button) to

65
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move it to the Trigger Sequence below.

3. Inthe Trigger Sequence, select and/or enter the appropriate labels, values,
and options.

To specify a label pattern event

Label pattern events let you specify patierns or ranges on a bus.

1. Select the label name button and choose the label that you want to look for
a pattern on.

You can also insert other label events if you want to look for multiple
patterns on multiple labels. Onee another label event is inserted, you can
choose And if both label events must occur in the same sample or Or if
only one of the label events must occur. ‘

2. BSelect the operator button and choose the appropriate operator.

The In range and Not in range operators consider the values you enter to
be inside the range. Ranges cannot be set on labels whose bits have been
reordered.

3. Select the number base button, and choose the number base that you
want, '

If the number base is changed in one window, the number base in other
windows may not change accordingly. For example, the number base
assigned to symbols is unigue, as is the nmumber base assigned in the
Listing window.

4. Enter the label value.

Xs mean you dort't care about the value on the specified bits. Xs are not
allowed in ranges.

If you chose the Symbols or Line #s number base, seiect the Absolute
XXXX button, and use the Symbo! Selector dialog to choose the symbol or
lne number value.

See Also “To specify a label edge event” on page 67
“To enter symbolic label values” on page 99
“Symbols Selector Dialog” on page 161

86
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To specify a label edge event

Label edge events let you specify edges and glitches on a bus. Label
edge events are only available in certain timing mode trigger functions.

1.

See Also

Select the label name button and choose the label that you want to look for
a pattern on.

You can also insert cother label events if you want to look for multiple
patterns on multiple labels. Once another label event is inserted, you can
choose And if both label events must occur in the same sample or Or if
only one of the label events must occur.

Select the edge assignment button.

In the Specify Edge/Glitch dialog, select the edges or glitches that you're
looking for on particular logic analyzer channels,

When you select multiple edges or glitches, they are ORed together, and
any one of the edges or glitches in a sample will satisfy the label edge
event. If you want to AND edges or glitches on a label, insert multiple label
edge events and AND them together.

Select the OK button.

“To specify a label pattern event” on page 66

To break down a trigger function

When a trigger function doesn’t quite let you set up the trigger you
want, you can break it down and edit the resulting advanced trigger
function.

1.

In the Trigger tab, select the number button of the trigger sequence level
whose trigger function you want to break down,

Choose Break down function.

Breaking down the trigger function will be permanent (although you can
choose the Undo command from the Edit menu if no other editing has
taken place).

If you only want to look the advanced trigger function, without editing it,
you can expand the trigger function.

Select OK in the confirmation dialog.

www.valuetronics.com

67



Chapter 2 Task Guide
Setfing Up Triggers and Running Measurements

To expand a frigger function

1. Inthe Trigger tab, select the number button of the trigger sequence level
whose trigger function you want to expand.

2. Choose Expand functiorn.

To compress a trigyer function

Expanded trigger functions can be compressed back into their original
form.

1, Inthe Trigger tab, select the number button of the trigger sequence level
whose trigger function you want to compress.

2. Choose Compress function,

See Also “Editing Advanced Trigger Functions” on page 77 for information on
editing trigger functions that are broken down.

To create a trigger funetion library

You can create your own libraries of trigger functions that are separate
from logic analyzer configuration files (unlike saved/recalled trigger
setups).

1. In the Trigger tab's Trigger Functions subtab, select the Trigger function
libraries button.

2. Inthe Trigger function libraries dialog, select the Create button.

3. Inthe Create User Library dialog, enter the library name and description,
and select OK.

4. In the Edit Trigger Function Library dialog, choose the Add function
button.

5. Inthe Create User Function dialog, enter the function name and
deseription, and select the levels from the current trigger sequence that be
the trigger function; then, select OK.

Once you have created a trigger function library with trigger functions,
you can: :

¢ Load or undoad the trigger function library.
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Insert and break down trigger functions from the loaded library just like
normal trigger functions.

Copy trigger function libraries to other logic analysis systems and load
them into other logic analyzers that have trigger function library capability.

Edit the trigger function library, adding or deleting functions, or delete the
library.

NOTE: If a trigger sequence or configuration file uses a trigger function library that
has been deleted, or a trigger function that has been deleted from a library,
the logic analyzer replaces the missing function with the default trigger
function.

To Icad/unload trigger function libraries

1.

In the Trigger tab's Trigger Functions subtab, select the Trigger function
libraries button.

Select the library from the list.
Only Hbraries created in the same sampling mode are available.
Select the Load (or Unload) button.

All of the library's trigger functions are added to (or removed from) the list
of trigger functions.

To copy trigger function libraries between systems

1

See Also

Connect your logic analysis system to the network, (see the Agilent
Techmnologies 16700A/B-Series Logic Analysis System help volume)

Using a computer on your network, copy the appropriate files from the /
logic/trigger functions/ directory to a central location, or
directly to other logic analyzers on the network,

“To break down a trigger function” on page 67
“Saving/Recalling Trigger Setups” on page 84
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Using State Mode Trigger Features

When the logic analyzer sampling mode is state, you can specify
whether a state or time count is stored with samples and you can set up
the default storing options.

e “To count states or time” on page 70
e “To Specify Default Storing” on page 70
e  “To specify whether default storing is initially on or off” on page 72

To count states or time

When the logic analyzer sampling mode is stale, you can specify
whether a state or titne count is stored with sarmples.

1. In the Trigger tab's Settings subtab), select the Count option button and
choose either Off, Time, or States.

2. If you chose States:
a. Select the Define button.

b. Inthe State count gualify dialog, select the Count if or Count if NOT
option.

¢. Specify events that identify the states to be counted or not counted.

d. If you would like to specify the evaluation order of the event list, select
Group events. Then, in the Group Events dialog, either select the Add
parens button to group events or select the Remove parens button to
ungreup events. When you're done grouping events, select the OK
button.

When time or state counts are turned on and all pods are assigned,
logic analyzer acquisition memory is halved to 1M samples. Leaving one
pod pair unassigned gives you full memory depth,

See Also “To agsign pods to one or two analyzers” on page 57

To Specify Default Storing
You can set up default storing so that only the data samples you're

70
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interested in are saved in logic analyzer acguisition mermory.

NOTE: Default storing in both state and timing modes require time tags to
reconstruct the data. These time tags will be stored either on a reserved tag
chip, or interleaved in the data.

1. In the Trigger tab’s Default Storing subtab, select the store by default
option button and choose either Angything, Nothing, Custom, or
Tramsitions.

Amnything means all samples are stored. Nothing means that no samples
are stored. Custom lets you specify which samples are stored. Transitions
lets you specify which fransitions to store on a per label basis.

2. If you chose Custom:
a. Select the Store if or Store if NOT option,
b. Specify events that identify the states to be stored or not stored.

c. Hyou would Hke to specify the evaluation order of the event list, select
Group events. Then, in the Group Events dialog, either select the Add
parens button to group events or select the Remove parens button to
ungroup events. When you're done grouping events, select the OK
buttorn.

3. If you chose Transttions (Timing mode only).

Transitional timing is a subset of store qualified timing. In transitionat
timing, the store gqualification is set to look for edges (transitions) on ail
active channels, Active channels are those that have been assignedtoa
Iabel in the Format tab. Samples are stored for all channels whenever a
transition oecurs. No other store qualification events are allowed.

For more information on store qualification in transitional timing mode,
refer to More on Store Qualification in Transitional Timing. (see page 38)

In the trigger sequence, you can override default storing for the
samples that cause actions to occur, or you can turn default storing on
or off, by inserting store actions.

The Agilent Technologies 16717A logic analyzer does not use the
"Branches taken" feature of past logic analyzers. The best way to store
only the states that cause sequence level branches is by setting up
default storing to Nothing, inserting a Store sample action in each

H
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sequence level, and inserting a Turn off defawult storing action in the
level that triggers.

NOTE: When store qualification is performed in the 333 MHz State mode, there may
be the case where data occupying memory is further disqualified. As a resulf,
you may see a non-contiguous listing of states as well as a reduction of usable
TNEMOTY,

Te clear default storing changes

1. When the Trigger tab is displayed, select Clear Default Store from the
Clear menu.

See Also “Storage Qualification” on page 201 in “Understanding Logic Analyzer
Triggering” on page 192

“Toc insert a store action (state mode)” on page 79

“To specify whether default storing is initially on or off” on page 72

To specify whether default storing is initially on or off

In the state sampling mode, you can specify whether the default
storing is initially on or off.

1. In the Trigger tab's Default Storing subtab, select the At siart of
acquisition option button and choose either On or Of.

See Also “Storage Qualification” on page 201 in “Understanding Logic Analyzer
Triggering” on page 192

“To insert a store action (state mode)” on page 79

*To Bpecify Default Storing” on page 70

Editing the Trigger Sequence

When you want to trigger on several events in the device under test
that follow one another, you need to use multiple levels in the trigger
sequence.

72
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For example, multiple levels in the trigger sequence let you trigger on a
particular function calling sequence or capture only the execution
within a particular program loop.

See Also

“To insert/replace/delete sequence levels” on page 73
“To cut/copy-and-paste sequence levels” on page 74
“To specify a level's goto or trigger action” on page 74
“To send e-mail when the trigger occurs” on page 75
“To view a picture of the trigger sequence” on page 77

“To clear the trigger sequence” on page 77

“Sequence Levels” on page 194 in “Understanding Logic Analyzer
Triggering” on page 192

To insert/replace/delete sequence levels

To insert sequence levels

1.

In the Trigger tab's Trigger Sequence area, select the level that you want to
insert before or after.

A yellow box appears around the level.

In the Trigger Functions subtab, select the trigger function you want to
insert.

A picture describing the trigger function is shown.

Select the Insert before or Insert after button, or select the level button
and choose Insert LEVEL before or Insert LEVEL after.

To replace sequence levels

1.

2.

In the Trigger tab's Trigger Sequence area, select the level that you want to
replace.

A yellow box appears arcund the level.

In the Trigger Functions subtab, seiect the trigger function you want to
ingert.

A picture describing the trigger function is shown.
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3. Select the Feplace button, or select the level button and choose Replace
LEVEL. '

To delete sequence levels

1. Inthe Trigger tab’s Trigger Sequence area, select the level that you want to
delete.

A yellow box appears around the level,

2. Belect the Delete button, or select the level button and choose Delste
LEVEL.

See Also “To cut/copy-and-paste sequence levels” on page 74

To cut/copy-and-paste sequence levels

You can change the order of levels in the frigger sequence by cutting-
and-pasting or you can copy levels by copying-and-pasting.

1. Inthe Trigger tab's Trigger Sequence area, select the level that you want to
cut or copy.

A yellow box appears around the level

2. Setect Cut level or Copy level from the Edit menu, or select the level
button and choose Cut LEVEL or Copy LEVEL.

3. Select the level that you want {o paste before or after.

4. Select Paste level before or Paste level after from the Edit meny, or select
the level buttor and choose Paste LEVEL before or Paste LEVEL after.,

See Alse “To insert/replace/delete sequence levels” on page 73

To specify a level’s goto or trigger action

When using multiple levels in the trigger sequence, you specify the
event search order by setting the goto or trigger action in each
sequence level,

1. Inthe Trigger tab's Trigger Sequence area, select the level whose goto or
trigger action you want to specify.

A yellow box appears around the level.

14

www.valuetronics.com



Chapter 2: Task Guide
Setting Up Triggers and Running Measurements

2. Select the Trigger or Goto button and choose the appropriate Goto or
Trigger action.

3. I you chose the Goto or Trigger and goto action, select the level button
and choose the appropriate level,

Searching for events that trigger the analyzer always starts at the first
level. Searching stops after one of the Trigger and fill memory
actions.

One level can branch to one of several other levels depending on the
evaluation of the sample. You can set up multi-way branches using
advanced trigger functions or by selecting an Jf button and choosing
Insert BRANCH.

NOTE: When you want to test a single sample for multiple conditions and take
different actions based on which is true, use branches within a trigger
sequence level. When you want to test different samples, use different
sequence levels.

See Also “Understanding Logic Analyzer Triggering” on page 192
“To view a picture of the trigger sequence” on page 77

“Advanced Trigger Functions” on page 153

To send e-mail when the trigger occurs

You can set up the logic analyzer to send e-mail when the trigger
occurs. This is useful when triggering on an event that rarely oceurs,
when you may not be around the logic analyzer to see that it triggered.

1. Inthe Trigger tab's Trigger Sequence area, select the level whose trigger
you want to send e-mail on.

A yellow box appears around the level.

2. Select the Trigger or Goto button and choose the Prigger, send e-mail,
and fill memory action. '

3. Select the F-mail Setup button.

4. Inthe E-mail Setup dialog, enter the name of the SMTP (see page 76) mail
server {if you don't know this, contact your Systemn Administrator), the

15

www.valuetronics.com



Chapter 2; Task Guide _
Seiting Up Triggers and Running Measurements

recipient’s e-mail address (use spaces to separate muitiple addresses), and
the text of the message,

If you want e-mail to be sent on each trigger of a repetitive run, select the
Send e-mail on repetitive run check box.

B. 'Select the OK button.

Note that the e-mail is sent when the trigger occurs and not after the
logic analyzer’s acquisition memaory is full.

You only need to specify one send e-mail action per trigger sequence.
As long as one trigger action sends e-mail, any trigger in the sequence
will result in e-mail being sent. (You cannot specify different send e-
matl setups in a trigger sequence.)

If the SMTP server has a prohiem with the defanit sender address

* You may need to specify a sender address that is recognizable by the
server. A possible address might be the one specified in the To: field.

Message Format The automatically generated text is shown as follows:
Example: system 14 : Slot C : Analyzer C has triggered

Where systeml4 is the analysis system IP address or alias you have
assigned to it; Slot C is the frame slot the module is in; Analyzer C
identifies the specific analyzer module from others when configured in
a multi-module frame configuration.

Any text you add in the text entry area of the e-mail setup dialog wili
appear after the automatically generated text.

What is SMTP? SMTP (Simple Mail Transfer Protocol) is a TCP/IP
protocol used in sending and receiving e-mail. A protocol is the special
set of rules for communicating the end points in a telecommunication
connection as they send signals back and forth.

Protocols exist at several levels in a telecommunication connection.
There are hardware telephone protocols. There are protocols between
the end points in communicating programs within the same computer
or at different locations. Both end points must recognize and observe
the protocol.

76
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On the Internet, there are the following TCP/IP protocols:

« TCP (Transmission Control Protocol), which uses a set of rules to
exchange messages with other Internet points at the information packet
level.

= IP (Internet Protocol), which uses a set of rules to send and receive
messages at the Internet address level.

s HTTP, FTP, SMTP and other protocols, each with defined sets of rules to
use with other Internet points relative to a defined sef of capabilities.

To view a picture of the trigger sequence

1. In the Trigger tah, select the Overview subtab.

A picture of the irigger sequence is shown,

‘See Also “Editing the Trigger Sequence” on page 72

To clear the trigger sequence

1. When the Trigger tab is displayed, select Trigger Sequerice or All from the
Clear menu.

Selecting Trigger Sequernce restores the default trigger sequence for the
selected sampling mode.

Selecting Ail restores the default trigger sequence, trigger settings, and
default storing if in the state sampling mode.

To restore default trigger settings
1. When the Trigger tab is displayed, select Settings from the Clear menu.

Settings (acquisition depth and trigger position) are returned to their
defaults. In the state sampling mode, time tags are turned back on. In the
timing sampling mode, the sample period returns to its fastest setting.

Editing Advanced Trigger Functions

After you break down a trigger function (if it didn’t quite provide the
trigger capability you need), or after you select one of the advanced

17
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frigger functions, you're ready to edit the advanced trigger function.

All trigger functions look for events and, if those events are found, take
actions.

Most often, the event is something that occurs on the probed signals
(label events), and the action is to trigger the logic analyzer. However,
events can also test timer, counter, and/or flag values that are set up in
the logic analyzer, and actions can include setting up timers, counters,
and flags as well as specifying special store actions.

e “To specify a duration or occurrence count for events {#iming mode)” on
page 78

s “To insert a store action (state mode)” on page 79

= “To insert timer actions/events” on page 79

s “To ingert counter actions/events” on page 80

» “To insert flag actions/events” on page 81

s “Toinsert a "reset occurrence counter” action” on page 83

s “To group events” on page 83

e  “To use named events” on page 84

To specify a duration or occurrence count for events
(timing mode)

When working with advanced {rigger functions or when you break
down other trigger funetions, you can specify that an event be present
for a certain amount of time, or occur in a certain number of samples,
before the associated action is taken.

Ta specify a time duration for events

1. In the Trigger tab's Trigger Sequence area, if the present for > bution is
not present, select the occurs button and choose present for >,

2. Enter a time duration value.

The event must be present for the specified period of time before the
action is taken.
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To specily a < duration, break down the Find pattern present for <
duration trigger fumction. (It actually uses occurrence counts and four
sequence levels.)

To specify an cccurrence count for events

1. Inthe Trigger tab's Trigger Sequence area, if the occurs button is not
present, select the present for > button and choose occurs.

2. Enter an occurrence count value.

3. If the occurrence count is greater than 1, select whether the event should
occur consecutively or eventually.

The event must occur the specified number of times before the action
is takem.

To insert a store action (state mode)

You can insert store actions to override the default storage qualifier for
the samples that cause actions to occur, and you can insert store
actions to turn default storing on or off.

1. Inthe Trigger tab’s Trigger Sequence area, select one of the action buttons
{for example, Trigger or Goto), choose fnsert ACTION, choose Store, and
choose either Store sample, Don't store sample, Turn on default
storing, or Turn off defouli storing.

You can use store actions to set up sequence level storage qualification.
See Also “Storage Qualification” on page 201 in “Understanding Logic Analyzer
Triggering” on page 192
“To Specify Default Storing” on page 70
“To specify whether default storing is initially on or off” on page 72

To insert timer actions/events

Timers are like stopwatches. You can insert actions to start (from
zero), stop (and reset), pause, or resume a timer. You can ingert timer
events in a different sequence level to test the value of a timer,

19
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NOTE: No timer is availabie for the first pod padr assigned to a logic analyzer. For
each additional pod pair assigned to the analyzer, an additional timer is
available,

To insert a timer action

i. Inthe Trigger tab’s Trigger Sequence area, select one of the action buttons
(for example, Trigger or Goto)}, choose fnsert ACTION, choose Timer, and
choose either Stavt from reset, Stop and reset, Pause, or Resume,

To insert a timer event

Timer events are like other events in that they evaluate to either true
or false.

1. Inthe Trigger tab’s Trigger Sequence area, select one of the existing event
buttons {for example, a label name, Anything, Timer, Counter, or Flag) and
choose to insert or replace a Timer.

2. Select the timer number button and choose the number of the timer you
want to test.

3. Select the operator button and choose either »>= or <.
4. Enter the time value,

The minimum value you can test a timer for depends on the timing/state
analyzer configuration.

See Also “To assign pods to one or two analyzers” on page 57

To insert counter actions/events

Global counters are available in the trigger sequence. You can insert
actions to reset or increment a counter. You can insert counter events
in a different sequence level to test the value of a counter.

To insert a counter action

1. Inthe Trigger tab's Trigger Sequence area, select one of the action buttons
{for example, Trigger or Goto), choose Insert ACTION, choose Counier,
and choose either Reset or Incremend.
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To insert a counter event

Counter events are like other evernts in that they evaluate to either true
or false,

1. Inthe Trigger tab’s Trigger Sequence area, select one of the existing event
buttons (for example, a label name, Anything, Timer, Counter, or Flag) and
choose to insert or replace a Counter.

2. Select the counter number button and choose the number of the counter
you warnt to test.

3. Select the operator button and choose either >= or <.

4, Enter the counter value.

To insert flag actions/events

Flags can be used to signal between modules in the logic analysis
system mainframe, an expansion frame, or in multiple frames
connected with the multiframe module.

There are 4 flags that are shared across all connected logic analysis
system frames. A flag may be driven or received by multiple modules.

Using flags, logic analyzer modules can communicate back and forth
with each other multiple titnes during a data acquisition, both before
and after their trigger events occur. (By comparison, the Intermodule
window lets one module arm another module one time when its trigger
occurs.)

By default, flags are cleared. You can insert actions io set, clear, pulse
set, or pulse clear a flag. You can insert flag gvents in different logic
analyzer modules o test whether a flag is set or clear.

NOTE: The 16760 logic analyzer can check flags by inserting an event, but cannot
change flag status with an action. Flag actions are nof available.

A flag that is set by a module remains set until that module clears it. If
multiple modules set the same flag, all of those modules must clear the
flag before it becomes clear.

Flags can also be used to drive the logic analysis system’s Port Out
signal.

#1
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To insert a flag action

You can use the Set/clear/pulse flag trigger function to insert a flag
action. When editing advanced trigger functions, follow these steps to
insert a flag action:

1. In the Trigger tab’s Trigger Sequence area, select one of the action buttons
(for example, Trigger or Goto), choose Insert ACTION, choose Flag, and
choose either Set, Clear, Pulse set, or Pulse clear.

Flags in Pulse mode it in the opposite state when not being pulsed. If you
insert a Pulse set action for a flag in one analyzer, you cannof insert a
Pulse clear action for the same flag in a different analyzer.

NOTE: Within an analyzer, the same flag cannot be used in both Pulse and Level (Set/
Clear) modes. If a flag action is inserted or modified with a different mode
than other actions for the same flag, all actions for that flag will change to
match the new mode.

2. If you chose Pulse set or Pulse clear, enter the width of the puise,

In timing mode, pulse width is settable from 54 ns to 1.53 us in 6 ns steps.
In state mode, pulse width is settable from 50 ns fo 1.275 ns in 5 ns steps.

NOTE: Within an analyzer, a flag’s pulse width must be the same in every action for
that flag. Whenever the pulse widih is changed in a flag action, it changes in all
other actions for that flag.

3. Select the flag number button and choose the number of the flag you want
the action to cccur on.

To insert a flag event

Flag events are like other evenis in that they evaluate to either true or
false.

You can use the Wait for flag trigger function to insert a flag event.
‘When editing advanced trigger functions, follow these steps to insert a
flag event:

1. Inthe Trigger tab’s Trigger Sequence area, select one of the existing event
buttons (for example, a label name, Anything, Timer, Counter, or Flag) and
choose to insert or replace a Flag.
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2. Select the flag number button and choose the number of the flag you want
to test.

3. Select whether you're testing if the flag is Set or Clear.

There is approximately 100 ns of delay before a flag action can be seen
by a flag event.

Te drive the Port Qut signal with a flag
1. Inthe main logic analysis system window, select the Port Out button.
2. In the Port Out dialog, select the Type, Polarity, and Output options.

When driving the Port Out signal with a flag, you can select the
Feedthrough type to pass the current state of the flag (set or clear)
directly to Port Out.

3. For the Armed by option, select the flag that will drive the Port Out signal.
4, Close the Port Out dialog,

5. Insert a flag action in one of the logic analyzer modules to drive the flag.
There is approximately 100 ns of delay between a flag action and the
signal on Port Out.

To insert a "reset occurrence counter" action

You can reset an occurrence counter if some event occurs by inserting
a "reset occurrence counter' action.

1. Inthe Trigger tab’s Trigger Sequence area, select one of the action buttons
{for example, Trigger or Goto), choose Insert ACTION, and choose Resat
occurrence counter.

See Also “To specify a duration or occurrence count for events (timing mode)}” on
page 78

To group events

When you are working with advanced trigger functions (or when you
break down other trigger functions) and there are multiple events in an
event list, you can specify their evaluation order by grouping the
events.
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1. Inthe Trigger tab’s Trigger Sequence area, select the If, If not, Else if, or
Else if not button, and choose Group events.

2. Inthe Group Events dialog, either select the Add parens button to group
events or select the Remove parens button to ungroup events.

3. Select the OK button.

To use named events

When you are working with advanced trigger functions {or when you
break down other trigger functions), you can narne an event list and
use it later when inserting or replacing events.

To give an event list a name

1. Inthe Trigger tab’s Trigger Sequence area, select the If, If not, Else if, or
Blse if not button, and choose Name event list.

2. Inthe Name Event List dialog, enter the name and select the OK button.

To insert a named event

1. Inthe Trigger tab’s Trigger Sequence area, select a label name button and
choose to insert or replace a Named event.

2. Inthe Named Event selection dialog, select the named event, and select
the OK button.

To edit a named event

1. Inthe Trigger tab’s Trigger Sequence area, select the named event button
and choose Edit locally or Edit globally.

Locally means to edit {and rename) this instance of the named event.
Globally means to edit all instances of the named event.

2. In the Edit dialog, edit the event list as you would edit it in the Trigger
tab’s Trigger Sequence area.

Saving/Recalling Trigger Setups

You can save a trigger setup within a session by using frigger save/

84
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recall.
*« “To save a trigger sefup” on page 85
e “Torecall a trigger setup” on page 85

¢ “To clear the trigger save/recall list” on page 85

See Also “Save/Recall Subtab” on page 157

To save a trigger setup

1. Set up the trigger.

2. Inthe Trigger tab's Save/Recall subtab, select the Save button.
3. Select a memory location to store the trigger setup in.
4.

In the Buffer Name dialog, enter a descriptive nare for the trigger setup.

To recall a trigger setup
1. Inthe Trigger tab's Save/Recall subtab, select the Recall button.

2. Choose the trigger setup from one of the previous measurements or one of
the save/recall memories.

Recalling a trigger setup changes the trigger arming, memory depth,
and trigger position as well as the trigger sequence. Recalling a trigger
setup will not change the sampling mode configuration.

If one of the settings in the recalled trigger setup conflicts with the
sampling mode configuration, it will be set to the closest setting,

Also, i the trigger setup uses a trigger function library that does not
exist on this mainframe, it will not load correctly.
To clear the trigger save/recall list

1. When the Trigger tab is displayed, select Save/Recall Memories from the
Clear menu.
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Running Measurements

After you set up a trigger, you're ready to run the logic analyzer
measurement.

* “To start/stop measurements” on page 86
e “If nothing happens when you start a measurement” on page 86

¢ “TPo view the trigger status” on page 87

To start/stop measurements

To start measurements

1. Select the Run Single -2} Run Repetitive _fi.ﬁ_’ﬂ;!, Group Run Single el

Run <221 starts only the instrument you are using. Single runs gather data
untit the logic analyzer memory is full, and then stop.

Repetitive runs e keep repeating the same measurement and are
useful for gathering statistics.

Group Run ke (or repetitive group run) starts all instruments attached
to group run in the Intermodule window.

Zaud gtarts all instruments currently placed in the workspace.
To stop a measurement

1. Select the Stop 5k

or Stop All button.

If nothing happens when you start a measurement

* Analyzers with deep memory take a noticeable amount of time to complete
a run. Because data is not displayed until acquisition completes, it may
look like nothing is happening, Check the Run Status window to see if the

86
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logic analyzer is still running.

* Messages such as "Waiting in level 1" may indicate you need to refine your
trigger.

s If the status shows as "Stopped", the analyzer either finished the
acquisition, or was unable to run. The cause of the problem is listed in the
bottom half of the Run Status window.

s Look for an error message in the message bar at the top of the window,
Common messages are "slow or missing clock" and "Waiting for trigger".

s If Bun briefly changed to Stop or Cancel, select the Window menu,
choose the logic analyzer's slot, then choose the Waveform or Listing
display.

See Also “Slow or Missing Clock™ on page 180

“Waiting for Trigger” on page 184

“Error Messages” on page 170

To view the trigger status

While a logic analyzer measurement is running, you can view the
trigger status to see the sequence level that is evaluating captured
data, oceurrence and global counter values, and flag values.

1. Inthe Trigger tab, select the Status subtab.

See Also Run status (in the system help volume).
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Displaying Captured Data

Once you have run a measurement and filled the logic analyzer's
acguisition memory with captured data, you can display the captured
data with one of the display tools.

You can use analysis tools to filter data and compare data sets.

You can also analyze captured data with toolsets like the Serial Analysis
Toolset and the System Performance Analysis Toolset.

*  “To open Waveform or Listing displays” on page 88

s  “To display Timing Zoom data” on page 89

= “Tp use other display tools” on page 90

*  “If the captured data doesn't look correct” on page 92

e “If there are filtered data holes in display memory” on page 92
e “To display symbols for data values” on page 93

s  “To cancel the display processing of captured data” on page 54

To open Waveform or Listing displays

Waveform displays are typically used when data is captured with the
timing sampling mode, and Listing displays are used when data is
captured with the state sampling mode.

1. From the Window menu, select your logic analyzer and choose the
Wawveform or Listing command.

as
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Waveform and Listing (and other) display tools provide global markers
that can be used to correlate data that is captured by different
instrument modules or displayed differently in other display tool
windows,

The Waveform and Listing display tools also give you the ability to
search for particular data values captured on labels.

Listing displays let you load inverse assemblers that will decode
captured data info assembly language mnemonics. From the Listing
display, you can also open Scurce Correlation Toolset (Source Viewer)

windows that can display the high-level language source code that is
associated with captured data.

“See Also Using the Digital Waveform Display Tool (see the Waveform Display Tool
help volume)

Using the Listing Display Tool (see the Listing Display Tool help volume)
Working with Markers (see the Markers help vohime) |

To display Timing Zoom data

1. From the Window menu, select your logic analyzer and choose the
TimingZoorm command,

Tips for interpreting Timing Zoom Data

* Ina siate measurement, Timing Zoom data may appear to be slightly off
from standard data, This is because the Timing Zoom data is asynchronous
to the clock signal, whereas the standard data is not sampled until after the
setup period.
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e In Waveform displays, Timing Zoom and the regular data are in different
windows. To view them together, select Edit -> Insert from the menu bar,

¢ In Waveform displays, if Timing Zoom and regular data do not correspond,
check that the display is set to Seconds/div. Because Timing Zoom has a
smaller sample period, when the display is set to Samples/div the data
become more divergent the farther from the trigger you scroll.

To use other display tools
You can add display tools to your logic analyzer via the Workspace
window.

1. Select the Workspace button (or from the Window menu, select System
and Workspace).

2. In the Workspace window, scroll down to the Display portion of the tool
icon list.

3. Drag the dispiay tool icon and drop it on the analyzer icon.
4. 'To open the display tool, select its icon and choose the Display command.,

You can use the Chart display tool to chart the data on a label over
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time. For example, if you use storage qualification (in the state
sampling mode) or the Pattern Filter analysis tool, you can chart
variable values.

You can use the Distribution display tool to show how often different
values (among the possible values) are captured on a label.

You can use the Compare analysis tool to show the differences between
fwo measurement data sets. For example, you can run a measurernent
on one circuit board, then run the same measurement on a different
circuit board (or on the same circuit board in different environmental
conditions), and compare the resuits.

You can use the Pattern Filter analysis tool to remove samples from a
measurement data set before displaying or exporting the data. This lets
you look at selected samples without having to re-capture data.

You can use the Serial Analysis toolset to convert streams of serial data
into parallel words which are easier to view and analyze.

You can use the Systern Performance Analysis toolset to do things like:
isolate the root cause of performance bottlenecks, measure function
execution times, view the occurrence rate of an event, analyze bus
occupation and bandwidth, analyze bus stability, analyze jitter or time
dispersion, etc.

See Also Using the Chart Display Tool (see the Chart Display Tool help volume)

Using the Distribution Display Tool (see the Distribution Display Thol
help volume)

Using the Compare Analysis Tool (see the Compare Tool help volume)

Using the Pattern Filter Analysis Tool (see the Pattern Filter Tool help
volume)

Using the Serial Analysis Tool (see the Serial Analysis Tool help volume)

Using the System Performance Analyzer (see the Systom Performance
Analyzer help volume)

Measurement Examples (see the Measurement Examples help volume)
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If the captured data doesn’t look correct

Intermittent Data Check for poor connections, incorrect signal levels on the hardware,
Errors incorrect logic levels under the logic analyzer’s Config tab, or marginal
timing for signals.

Unwanted Triggers  If you are using an inverse assembler or a pipeline, triggers can be
caused by instructions that were fetched but not executed. To {ix, add
the prefetch queue or pipeline depth to the frigger address.

The depth of the prefetch queue depends on the processor that you are
analyzing, and can be quite deep.

Another solution which is sometimes preferred with very deep prefetch
queues is to add writes to dummy variables to your software. Put the
instruction just before the area you want to trigger on, then trigger on
the actual write to this variable. Although the instruction is prefetched,
the analyzer can be set to only trigger when the write is executed.

Capacitive Loadingon Excessive capacitive loading can degrade signals, resulting in

the Device Under Test gygpicious data or even system lockup. All analysis probes add
capacitive loading, as can custom probes you design for your device
under test. To reduce loading, remove as many pin protectors,
extenders, and adapters as possible.

Careful layout of your device under test can minirmize loading problems
and result in better margins for your design, This is especially
important for systems running at frequencies greater than 50 MHz.

If there are filtered data holes in display
memory :

When an analyzer measurement occurs, acquisition memory is filled
with data that is then transferred to the display memory of the analysis
or display tools you are using, as needed by those tools. In normal use,
this demand driven data approach saves time by not transferring
unnecessary data.
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Since acquisition memory is cleared at the beginning of a
measurement, stopping a run may create a discrepancy between
acquisition memory and the memory buffer of connected tools. Without
a complete trace of acquisition memory, the display memory will
appear to have "holes’ in it which appear as filtered data.

This situation will occur in these cases:

¢ If you stop a repetitive measurement after analyzer data has been cleared
and before the measurement is complete,

e If a trigger is not found by the analyzer and the rarn must be stopped to
regain control.

To make sure all of the data in a repetitive run is available for viewing:
1. Inthe workspace, attach a Filter tool to the output of the analyzer.

2. Inthe Filter, select "Pass Matching Data®

3. In the filter terms, assure the default pattern of all "Don't Cares” (Xs).

This configuration will always transfer all data from acquisition
memory. While this configuration will increase the time of each run, it
will guarantee that repetitive run data is available regardless of when it
is stopped.

To display symbols for data values

You can display data in symbolic form in some of the display tools, such
as the Listing display and the Waveform display.

o view symbalic values in a waveform display
1. Select the label name where you want to display symbolic values.
2. Select Change attribuies....
3. Inthe Attribute Dialog:
* Set ShowValue to On.
¢  Set Base to Symbois or Line#.
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¢ Select the OK button.

The symbolic names for the values now appear in the overlaid bus
waveform.

To view symbelic values in a listing display

1. Select the numeric base of the label where you want to display symbeolic
valies,

2. Set the numeric base to Symbols or Line#.

The symbolic names for the values now appear instead of numeric data.

See Also “{Jsing Symbols” on page 95

To cancel the display processing of captured
data

You can cancel the processing of captured data if it is taking too long.

1. Select the Cancel L buttor.

www.valuetronics.com



Chapter 2: Task Guide
Using Symbels

Using Symbols

You can use symbol names in place of data values when:

Setting up triggers

Displaying captured data

Searching for patterns in Listing displays

Setting up pattern filters

Setfing up ranges in the System Performance Analyzer

Symbol names can be: variable names, procedure names, function
names, source file line numbers, etc.

You can load symbol name definitions into the logic analyzer from a
program’s object file or from a general-purpose ASCI format symbol
file, or you can define symbol names in the logic analyzer.

L]
[

See Also

“To load object file symbols” on page 96

“To adjust symbol values for relocated code” on page 97

“To create user-defined symbols” on page 98
“To enter symbolic label values” on page 99
“To create an ASCII symbol file” on page 100

“To create a readers.ini file” on page 100

“To specify a label pattern event” on page 66

To go to a pattern in the Listing (see the Listing Display Tool help
volume)

To modify the Source Viewer trace setup (see the Listing Display Tool
help volume)

To define System Performance Analyzer state interval ranges (see the
System Performance Analyzer help volume)
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To load object file symbols

Obiect files are created by your compiler/linker or other software
development tools.

1. Generate an object file with symbolic information using your software
development tools.

2. If your language tools cannot generate object file formats that are
supported by the logic analyzer, create an ASCII symbol file (see
page 100).

3. Select the Symbol tab and then the Object File tab.
4, Select the label name you want to load object file symbols for.

In most cases you wili select the label representing the address bus of the
processor you are analyzing,

5. Specify the directory to contain the symbol database file (%) in the fleld
under, Create Symbol File (.ns) in This Directory. Select Browse... if
you wish to find an existing directory name.

6. Inthe Load This Object/Symbol File For Label field, enter the object file
name containing the symbols. Select Browse... to find the object file and
select Load in the Browser dialog.

If your logic analyzer is NFS mounted to a network, you can select object
files from other servers.

7. If your program relocates code, see “To adjust symbol values for relocated
code” on page 97.

The name of the current object file'is saved when a configuration file is
saved. The object file will be reloaded when the configuration is loaded.

To reload ebject file symhbols

1. Select the object file/symbol file to reload from the Object Files with
Symbols Loaded For Label field.

2. Select the Reload button.

The values of the object file symbols being used in the trigger sequernce
or in SPA state-interval ranges will be updated automatically each time

9
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the object file symbols are reloaded.

To delete object file symbol files

1
2.

See Also

Select the Symbol tab, and then the Object File tab.

Select the file name you want to delete in the text box labeled, Object
Files with Symbols Loaded For Label,

Select Unload.

“Symbol File Formats” on page 163

To adjust symbol values for relocated code

Use this option to add offset values to the symbols in an object file, You
will need this if some of the sections or segments of your code are
relocated in memory at run-time. This can occur if your system
dynamically loads parts of your code so that the memory addresses
that the code is loaded into are not fixed.

To adjust symbel vaiues for a single section of code

1.
2.

6.
T,

Select the Symbol tab and then the Object File tab.

In the Object Files with Symbols Loaded For Label list, select the file
whose symbols you wish to relocate.

Select the Relocate Sections... button.

In the Section Relocation dialog, select the field you wish to edit in the
section list.

Enter the new value for that field and press Enter on your keyboard.
Repeat steps 4 through 6 above for any other sections to be relocated.

Select Close,

To adjust ali symbol vaiues

1.
2.

Select the Symbol tab and then the Object File tab.
In the Object Files with Symbols Loaded For Label list, select the file
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whose symbols you wish to relocate.
Select the Relocate Sections... bution.

Enter the desired offset in the Offset all sections by field. The offset is
applied from the linked address or segment.

Select Apply Offset.
Select Close.

To create user-defined symbols

&

R A

Under the Symbol tab, select the User Defined tab.
Select the label name you want to define symbols for.

At the bottom of the User Defined tab, enter a svimbol name in the entry
field.

Select. a numeric base.

Select Pattern or Eange type for the symbol,

Enter values for the patfern or range the symbol will represent.
Select Add.

Repeat steps 3 through 7 for additional symbols.

You can edit your list of symbols by replacing or deleting them, if desired.

To replace user-defined symbols

ot

. Under the Symbol tab, select the User Defined tab.
. Select the label you want to replace symbols for,

1
2
3.
4

Select the symbol to replace.

. At the bottom of the User Defined tab, modify the symbol name, numeric

base, Pattern/Range type, and value, as desired.
Select the Replace button.

Repeat steps 3 through 5 to replace other symbols, if desired.
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Te delete user-defined symbols

1.

AN

Under the Symbol tab, select the User Defined tab.
Select the label you want to delete symbols from.
Select the symbol to delete.

Select the Delete button.

Repeat steps 3 and 4 to delete other symbols, if desired.

To load user-defined symbols

If you have already saved a configuration file, and the configuration
included user-defined symbols, load the file with its symbols, as
follows:

i

See Also

{n the menu bar of your analyzer window, select File and then Load
Configuration....

In the Load Configuration dialog, select the directory and filename to be
loaded.

Select the target of the load operation.
Select Load.

User-defined symbols that were resident in the logic analyzer when the
configuration was saved are now loaded and ready to use.

“To specify a label pattern event” on page 66

To enter symbolic label values

When entering label values in the trigger sequence:

1.
2.
3.

Choose the Symbols or Line #s number base.
Select the Absolute XXXX button.

In the Symbol Selector dialog, select the symbol you want to use. All of
your symbols for the current label, regardless of type, will be avaflable in
the dialog.
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s Use the Search Pattern (see page 162} field to filter the list of symbols
by name. You can use the Recall button to recall a desired Search
Pattern.

¢ [Jse the Find Symbols of Type selections to filter the symbols by type.
4. Select the symbol you want to use from the list of Maiching Symbols.
5. I you are using object file symbols, you may need to:

e Set Offset By (see page 162) to compensate for microprocessor
prefetches.

+ Set Align to x Byte (see page 163} to trigger on odd-byte boundaries.
6. Select the Beginning, End, or Range of the symbol.
7. Select the OK butfon.

The name of your symbol now appears as the value of the label.

8. Select the Cancel button to exit the Symbel Selector dinlog without
selecting a symbol.

See Also “To specily a label edge event” on page 67
“Symbols Seiector Dialog” on page 161

To create an ASCH symbol file

General-purpose ASCII symbol files are created with text editing/
processing tools.

See Also “General-Purpose ASCII (GPA) Symbeol File Format” on page 164

To create a readers.ini file

You ean change how an ELF/Stabs, Ticoff or Coff/Stabs symbol file is
processed by creating a reader.ini file.

1. Create the reader.ini file on your workstation or PC.

100
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2. Copy the file to /logic/symbols/readers.ini on the logic analysis system.

Beader options C++Demangle

L= Turn cn C++ Demangling ({(Default)
0= Turn off Ci++ Damangling

C++DemOptions

803= Standard Demangling

203= GNU Demangling {Default ELf/Stabs)

403= Lurid Demangling

800= Standard Demangling without function parameters
200= GNU Demangling without function parameters
400= Lucid Demangling without function parameters

MaxSymbolWidth

§0= Column width max of a functicn or variable symbol
Wider symbols names will be truncated.
(Defauld B0 columns}

DutSectionSymbolValid

= Symbols whose addresses aren’t within the
defined sections are invalid (Default)

l= gymbolis whose addragses ayren’t withia the
defined secticns are valid

This option must be specified in the Nsr section of the Readers.ini file:

iNer}
OutSectionSymbolValidsl

ReadElfSection

2= Process all globals from ELF section (Default)
Get size information of local variables

1= det size information of global and local vaxriables
Symbols for functiona will not be read, and
only supplemental informabtion for those symbols in
the Dwari or stabs section will be read.

0= Do nob read the Elf Section

If a file only has an ELF section this will have no effect and the ELF
section will be read completely. This can occur if the file was created
without a "generate debugger information” flag (usually -g). Using the -
g will create a Dwarf or Stabs debug section in addition to the ELF
section.

StabsType

Stabslype=0 Reader will determine stabs type {Default)
StabaType=1 Older atyle stabs
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{Qlder style stabs have individual symbol
tables for each file that was linked into
the target sxecutable, the indexes of each
symbol table restazrt at ¢ f£for each file.)
StabsType=2 Newer style atabs

{New style astaba have a single symbol table
where all symbols are merged intoc a large
symbol array)-

ReadOniyTicoffPage

ReadOnlyTicoffPage tells the ticoff reader to read only the symbols
associated with the specified page {as an example
"ReadOnlyTicoffPage=(’ reads only page 0 symbols). A value of -1 tells
the ticoff readers to read symbols associated with all pages.

ReadOnlyTicoffPage=~1 Rezd z]l] symbols associated will all
tigoff pagea (Default)

ReadOnlyTicoffPage=p Read anly synmbale associated with
page 'p’ {where p is any integer
between 0 and n the last page of
the object £ile).

AppendTicoffPage

AppendTicoffPage tells the ticoff reader to append the page number to
the symbol value. This assumes that the symbol value is 16-bits wide
and that that page number is a low positive number which can be ORed
into the upper 16 bits of an address to create a new 32-bit symbol
address. For example, if the page is 10 decimal and the symbol address
is 0xF100 then the new symbol address will be OxAF100.

AppendTicoffPage=l 2Append the ticoff page to the mBymbol
address

AppendTicofiPage=0 Do not append the ticoff page to the
symbol address (Pefaslt)

Examples Example for Eit/Stabs

[ReadersElf]

C

&
MaxSymbolWidth=60
StabsType=2

Example for Coff/Stabs (using Ticeff reader)

[ReadersTicoff]
C
C
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MaxSymbolWidth=60
StabsType=2

Example for Ticoff

[{ReadersTicoff]

c

c

MaxSymbolWidth=60
ReadOnlyTicoffPage=4
AppendTicoffPage=1
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Printing/Exporting Captured Data

To print captured data
You can print captured data from display tool windows.

1. In the display tool window, select Print this window from the File menu.

To export captured data

You can use the File Out tool to save measurement data to an ASCH
format file which can then be imported into a spreadsheet application,
a debugger, or some other post-processing tool.

1. Select the Workspace button {or from the Window menu, select System
and Workspace).

2. In the Workspace window, scroll down to the Utilities portion of the tool
tcon list.

3. Drag the File Out tool icon and drop it on the analyzer teon.

4. To open the File Out tool, select its icon and choose the Display
command.

5. Select the file name, automatic file sequencing, and output file format
options.

6. Select the Save Data button.

To re-import captured data

You can use the File In tool to re-import measurement data into the
logic analysis system for further analysis.

1. Select the Workspace button {or from the Window menu, select System
and Workspace).

2. In the Workspace window, scroli down to the Utilities portion of the fool
icon list.

3. Drag the File In tool icon and drop it in the workspace.

4. To open the File In tool, select its icon and choose the Display command.
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5. Select the file name and automatic file sequencing options.
6. Select the Read File button.

7. Drag display, analysis, or toolsef icons and drop them on the File In tool
icon to view the imported data.

See Also Printing Windows - Configurations (see the Agilent Technologies 1670047
B-Series Logic Analysis System help volume)

Using the File Out Tool (see the File Gul Tool help volume)
Using the File In Tool (see the File In Tool help volume)
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Cross-Triggering

An instrument must be armed before if can look for a trigger. By
default, instruments are set to be armed immediately when you Run
the measurement.

However, you can set an analyzer instrument to be armed either by the
second analyzer within the same instrument (if it's turned on) or by
another instrument (in a different slot or frame}.

*  “To cross-trigger between ﬁwo analyzers” on page 106

® “Tocross-trigger with another instrument” on page 107

To cross-trigger between two analyzers

1. Make sure both analyzers are turned on. To turn on the second analyzer:
a. Inthe Formai tab, select the Pod Assignment button.

b. Inthe Pod Assignment dialog, change the analyzer type from Qff to
either State or Timing.

The systemn pauses while setting up the second analyzer. When it is
done, a setup window fur the second analyzer appesrs.

in the analyzer waiting for the arm signal

1. Inthe Trigger tab's Trigger Sequence area, select the sequence level that
that should wait for the other analyzer's trigger.

2. Inthe Trigger Functions subtab, select the Wait for second analyzer to
trigger trigger function and select either the Replace or Insert before
button.

(You can also use an advanced trigger function, edit it, and insert an
Analyzer<@> triggers event.)

In the analyzer driving the arm signal

1. Set up the logic analyzer trigger as you would normally.
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2. Run the measurement.

To cross-trigger with another instrument

1.

Select the Intermodule button {or from the Window meny, select System
and Intermodule).

In the Intermodule window, select the icon of the ingtrument to be armed,
and choose the instrument that will arm it.

When the legic analyzer waits for the arm signal

1.

In the Trigger tab’s Trigger Sequence area, select the sequence level that
should wait for the other analyzer's trigger.

In the Trigger Functions subtab, select the Wait for arm in trigger
function and select either the Replace or Insert before button.

{(You can also use an advanced trigger function, edit it, and insert an Arin
in from IMB event.)

NOTE: If the trigger sequence does not pass through the level containing the wait for
arm event, the logic analyzer will not wait for the arming signal.

When the logic analyzer drives the arm signal

1.

See Also

In the Trigger tab’s Settings subtab, select the analyzer (or analyzers) that
will be used to drive the arm signal.

Set up the logic analyzer trigger as you would normally.

in the Trigger tab’s Trigger Sequence area, the trigger actions will show
arm oul to indicate that the logic analyzer's trigger is driving the arm
signal.

Run the measurement.

Intermodule Window (see the Agilent Technologies 16700A/B-Series
Logic Analysis System help volume)

Group Run Arming Tree (see the Agilent Technologies 167004/B-Series
Logic Analysis System help volume}

www.valuetronics.com
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Solving Logic Analysis Problems
o “Tofest the logic analyzer hardware” on page 108

See Aiso ¢ “If nothing happens when you start a measurement” on page 86
e “Ifthe captured data doesn't look correct” on page 92

o “f there are filtered data holes in display memory” on page 92

To test the logic analyzer hardware

In order to verify that the logic analyzer hardware is operational, run
the Self Test utility. The Self Test function of the logic analysis system
performs functional tests on both the system and any installed
modules.

1. Disconnect all probes of the logic analyzer module.

2. If you have any work in progress, save it to a configuration file, {see the
Agilent Technologies 16700A/B-Series Logic Analysis System help
volume)

3. Disconnect all loads, adapters, or anatysis probes from the probe cable
ends.

4. From the system window, select the System Admin icon.
5. Select the Admin tab, then Self Test....
The system closes all windows before starting up Self Test,
8. Select Master Frame.
If the module is in an expansion frame, select Expansion Frame.
7. Select the logic analyzer that you want to test.
8. In the Self Test dialog box, select Test All.

You can also run individual tests by selecting them. Tests that require you
to do something must be run this way.
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If any test fails, contact your local Agilent Technologies Sales Office or
Service Center for assistance.

Self Test (see the Agilent Techwnologies 16700A/B-Series Logic Analysis

See Also
System help volume)
Agilent Techmologies 16717A 333 MHz State/2 GHz Timing Zoom
Service Guide
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Saving and Loading Logic Analyzer
Configurations

The Agilent Technologies 16717A logic analyzer settings and data can
be saved to a configuration file.

The configuration file will include references to any custom trigger
libraries you have created, but if the configuration is loaded into an
analyzer on a system that does not have the trigger libraries, they will
not work correctly.

You can also save any tools connected to the logic analyzer. Later, yvou
can restore your data and settings by loading the configuration file into
the logic analyzer.

The Agilent Technologies 16717A logic analyzer can load
configurations for Agilent Technologies 16715A, 16716A, and 16717A
logic analyzers with no restrictions.

The Agilent Technologies 16717A logic analyzer can also load
configuration files generated for the Agilent Technologies 16550A,
16554A, 165bbA, 1656551, 165564, 165561, 165570, 167104, 167114,
167124, and 16600A-series logic analyzer modules, but much of the
triggering setup will not transfer. Labels, pod and clock assignments,
and the measurement mode will still work. Setup-and-hold values are
translated by preserving the hold value and adjusting setup
accordingly.

Note that while the eye finder (automatic sampling position
adjustment) selected sampling positions are saved and loaded with
logic analyzer configuration files, eye finder measurement data is not.
You can save eye finder data to separate files (see “To automatically
adjust sampling positions” on page 47).
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NOTE: The Agilent Technologies 16700A/B logic analysis systems can translate
configuration files from Agilent Technologies 16500 and 16505A logic analysis
systems if the measurement module is the same.

If the moduies are different, first load the configuration file into a module of
the same model number on the new logic analysis system. Re-save the
configuration, then load this configuration into the destination module on the
new system.

To save logic analyzer configurations

See Saving Configuration Files (see the Agilent Technologies 167004/
B-Series Logic Analysis System help volume).

To load fogic analyzer configurations

See Loading Configuration Files {see the Agilent Technologies
16700A/B-Series Logic Analysis System help volume).
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“The Sampiing Tab” on page 115

“The Format Tab” on page 119
o  “The Trigger Tab” on page 146
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¢ “The Symbols Tab” on page 159
*  “Error Messages” on page 170

* “Specifications and Characteristics” on page 186
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The Sampling Tab

The Sampling tab lets you choose between the logic analyzer’s
asynchronous sampling Timing Mode or its synchronous sampling State
Mode. This tab also lets you set controls for the selected mode as well
as Timing Zoom options.

+  “Timing Mode” on page 116
¢ “State Mode” on page 117
See Also “Choosing the Sampling Mode” on page 36
“Vsing 2 GHz Timing Zoom” on page 54
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o Sample Full

When you select Timing Mode, the Timing Mode Controls area appears.

Full/Half

Channel

Configuration Lets you configure the timing analyzer for faster sampling
and greater memory depth, but with half the channels.

Trigger Position Lets you specify where the sample that triggered the
analyzer should appear among all the other samples that
are stored in acquisition memory.

Aequisition

Depth ‘Lets you use a smaller portion of the acquisition memory
and speed up processing of the captured data,

Sample Period Lets you specify how often the the logic analyzer samples
signals from the device under test.

See Also “Selecting the Timing Mode (Asynchronous Sampling)” on page 36
“In Either Timing Mode or State Mode” on page 52
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State Mode

When you select State Mode, the State Mode Controls area appears.

167 MHz/333

MHz State

Speed

Configuration Lets you configure the state analyzer for faster sampling,
but with clocking restricted to the J clock on Pod 1 of the
master card and triggering restricted to two trigger
functions.

Trigger Position Lets you specify where the sample that triggered the
analyzer should appear among all the other samples that
are stored in acquisition memory.

Acquigition

Pepth Lets you use a smaller portion of the acquisition memory
and speed up processing of the captured data.

Clock Setup Lets you specify: the clock mode, the clock signal edges
from the device under test that wili be used as the sarapling
clock, and the clock input signal levels (from the device
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under test) that will enable (qualify) the sampling clock.

Generally, the state mode sampling clock is taken from the
signals that clock valid data in the device under test.

The clock channel specifiers graphically show your clock
setup. Edges are ORed ("+") together, and qualifiers are
ANDed (".") to all edges. To qualify just one of the edges,
switch to Advanced Clocking.

Al clock channels for the clock setup must be on the pods
of the master card of the module, but the pods do not
need to be part of the state measurement.

Advanced
Clocking Lets you specify more complex clock setups than you can
with the normal Master {and perhaps Slave) buttons that
are available for each pod.
See Alse “Selecting the State Mode (Synchronous Sampling)” on page 43

“In Either Timing Mode or State Mode” on page b2
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The Format Tab

The Format tab lets you assign bus and signal names (from the device
under test), to logic analyzer channels. These names are called labels.
Labels are used when setting up triggers and displaying captured data.

The Format tab also lets you assign pod pairs to one or two logic
analyzers, specify the logic analyzer threshold voltage, and adjust the
logic analyzer setup/hold {sampling positions).

The Data On Clocks display column shows all the clock inputs available
as data channels in the present configuration, including the clocks on
expander cards that cannot be used in the clock setup.

The Format tab has activity indicators that show whether the signal a
channel is probing is above the threshold voltage (high), below the
threshold voltage (low), or transitioning.

¢+ “Pod Assignment Dialog” on page 130
¢ “Sampling Positions Dialog” on page 131
¢ “Manual Setup/Hold Option” on page 144
e “Eye Finder Option, Setup Tab” on page 132
* “Eye Finder Option, Results Tab” on page 184
A label can have up to 32 channels.
Fach measurement can define 126 labels.

Labels containing clock bits cannot be used in range terms where the
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clock bits span more than one pod pair.

See Also “Formatting Labels for Logic Analyzer Probes” on page 57
“To manually adjust sampling positions” on page 50
“To automatically adjust sampling positions” on page 47
“Importing Netlist and ASCIE Files” on page 121
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Importing Netlist and ASCII Files

Netlist Files The Netlist Import feature provides a method for importing busses and
signals from ASCII netlists created by EDA tools. In order for the
feature to work, the device under test must either use the Agilent
EbB346A high density adapter or the Agilent Technologies Termination
Adapter. The adapter must be included as a connector in the netlist.

You can create a Netlist file using an EDA tool. When importing a
Netlist file, you can specify which connectors are of interest;
connectors that are nof specified will be ignored.

Examgple

NET' /Busl (3) *J1-7

Buéi Four bit bus

3) Bit 3

J1-7 Connector J1, pin 7

To Import a Net List

1. Configure the connector names referenced in the Netlist to logic analyzer
pods.

2. Specify the Net List file to import.

3. Verify that Nets were correctly mapped to Labels, Pods, and Channels.

4. Select or create labels to appear in the interface.
Map the Cornector Names {see page 127),
Import the Net List File (see page 127)
Verify Net to Label Mapping (see page 128)
Select/Create Interface Labels (see page 129)

ASCII Files You can create an ASCII file using any Windows, MS-DOS, or UNIX text

editor. The ASCII file shouid contain bus names, pod/clock numbers,
and channel definitions.
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Fer Example

Labell;A2[15:5];A1[5,2]

Labell Bus Name

A2 and Al Pod Numbers

[15:5] Channel 15 through Channel] 5 (Prssikiokiit 1
[5,2] Channel 5 and Channet 2 ("........*%.*.")

When setting up the ASCII file a comma (",") separates individual
channels, while a colon (":") creates a range of channels.

The following provides an explanation of how to setup and import
ASCII files into a logic analysis system.

Setting Up ASCIi Files

NOTE: If the analyzer is in state mode with the Clock Setup Mode set to
demultiplexer, slave pods will appear with an "S" in front of the pod
designation.

For example:

Labell;SA2{5] reads as Labell maps to Slave Pod A2 Channel 5.

Individual channels

Labell;A2[5] Labell maps to Pod A2, Channel 5

Multiple chanasls

Labell;A1[5:2,0] Labell maps to Pod Al, Channel 5 through Channel 2 and
Channel 0,

Individual channeis en different pods

Labell;A2[1];Al

[0} Labell maps to Pod A2, Charmnel 1 and Pod Al, Channel 0.

Multiple chiannels on different pods

Labell:A3{15:5];
AZ[5];A1]6] Labell maps to Pod A3, Channel 15 through Channei 5,
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Pod A2 Channel 5, and Pod Al Channel 6.

Cloeks

Labell;CK[AK] Labell maps to Slot A Clock K.
“Importing ASCII Files” on page 123
“Exporting ASCIH Files” on page 123

See Also “Fermination Adapter” on page 125

“E5346A High Density Adapter” on page 126

Considerations when creating an Import file.

When updating a label ensure that the label is turned on. Labels that
are not active will not be updated.

Other considerations:
s Maximum of 126 labels

e  Maximum of 20 characters per label. (The system truncates after 20
characters.}

e  Maximum of 32 channels per label.

Exporting ASCII Files
1. Select the Format tab.
2. Select File, then select Export Label...

Importing ASCII Files

Shown below is the default setup:

Labell;ALil5:0}
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'l:a Import an ASGH 1. Create an ASCII file for importing into the logic analysis system. For
file. example:

1ab2;A215:10,6,3]
NewLabel2,AZ[15}
Labeil;Al[15:0]
2. Select the Format tab,
3. Select File, then select Import Labels. ..
4. Select the ASCII file you created.

©. /legic/data/

5. Select OK.
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Termination Adapter

The logic analyzer cable must have the proper RC network at its input
in order acquire data correctly. The Termination Adapter incorporates
the RC network into a convenient package. It also reduces the number
of ping required for the header on the target board from 40 pins to 20.
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Loguc Analyzer
P

Terwitahon
Adamier

Target

b

eyt A 0r " ‘E@&
Lo s w@;}‘ )
ik o~

Eb346A High Density Adapter

The E5346A high-density adapter provides a convenient and easy way
to connect an Agilent logic analyzer to the signals on your target
system for packages that are difficult to probe. An Amp "Mictor 38"
connector must be installed on your target system board.
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Logic Analyrer

Mighdensity
Adapgr Catie

~/

EA

Evan Pog

Mapping Connector Names

1. Select the Format tab.

Select File, then select Imnport Netlist.

Select Next to go to the Mapping Connector Names dialog.

Enter a connector name from the Netlist.

Select the type of adapter.

Select the logic analyzer pods that are plugged into the adapters.

T

To map more connector names, select Add Connector and repeat the
steps above.

8. Select Next.

Import the Net List File

1. Select Select Netlist File.
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2. Select the file from the File Selection dialog box.
3. Select OK
4. Select Next

Verify Net to Label Mapping

1. Verify that each net was properly imported into a label.
2. Select Next

The list provided, see example below, is the mapping from the logic
analyzer pods and channels to labels,

The label column is editable so you can make changes if necessary. If
you need to delete labels, this can be done more efficiently in the next
dialog box.

Histheermpirrrtrfirding)

K—= Priev Next ——>i
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Select/Create Interface Labels

Select any additional labels to be copied into the Format tab. Typically
there is no need to add any more labels. However, this screen is useful
when you want to designate a signal bit in a bus as a separate label
name. If can also be used to delete unneeded labels.

Once you have completed editing the labels, select Done.
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Pod Assignment Dialog

 D1-E it i Ea

MR iitritiein

Name: Lets you name the analyzers.

Type: Lets you seleet the timing (asynchronous) sampling mode,
the state (synchronous) sampling mode, or turn the
analyzer off.

Pod Pairs Can be dragged-and-dropped under one of the analyzers to
assign those channels to the analyzer or can be left
unassigned.

See Also “To assign pods to one or two analyzers” on page 57

“To name an analyzer” on page 53
“To setect the timing mode” on page 40
“To select the state mode” on page 44

“To turn an analyzer off or on” on page 53
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Sampling Positions Dialog

The Sampling Positions dialog lets you position the logic analyzer’s
setup/hold window (or sampling position) so that data on high-speed
buses is captured accurately, in other words, so that data is sampled
when it is valid.

When the device under test’'s data valid window is less than 2.6 ns
(roughly, for clock speeds >= 200 MHz), it’s easiest to use eye finder
o locate the stable and transitioning regions of signals and to
automatically adjust sampling positions.

When the device under test’s data valid window is greater than 2.5 ns
{roughly, for clock speeds < 200 MHz), it's easiest to adjust the
sampling position manually, without using the logic analyzer to locate
the stable and transitioning regions of signals.

“Eye Finder Option, Setup Tab” on page 132

e “Eye Finder Advanced Settings Dialog” on page 133
¢+ “Eve Finder Option, Results Tab” on page 134

e “Eye Finder Run Messages” on page 136

¢ “Eye Finder Info Messages” on page 139

“Eye Finder Load/Save Messages” on page 141
s “Eve Finder Option, File Info Tab” on page 142
¢ “Manual Setup/Hoid Option” on page 144

See Also “Understanding State Mode Sampling Positions” on page 208
“Selecting the State Mode (Synchronous Sampling)” on page 43
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Eye Finder Option, Setup Tab

‘Advanced,

File menu

Lets you save/load eye finder data.

EyeFinder menulets you run eye finder, choose the run mode, and access

Run Mode

Repetitive Run

Advanced

Label Selection

the “Eye Finder Advanced Settings Dialog” on page 138,

Lets you lock at eye finder with dermo data or in normal

operating mode by sampling signals from the device under
test.

Runs the eye finder repetitively, so you can see how stable
and transitioning signals vary over time,

See “Eye Finder Advanced Settings Dialog” on page 133.

Lets you choose the labels (channels) to run eye finder on.
You car: expand or overlay the signals in a label, select all or
select none of the signals, select individual signals, or select
multiple signals.
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If a channel appears in multiple labels, selecting that
channel will select it in each of those labels.

See Also “Understanding State Mode Sampling Positions” on page 208

“To automatically adijust sampling positions” on page 47

Eye Finder Advanced Settings Dialog.

Short Eye finder looks at 100,000 clock cycles on each channel
to determine the suggested sampling positions. This setting
requires frequent transitions on all charmels.

Medium Eye finder looks at 500,000 clock cycles on each channel
to determine the suggested sampling positions. Use this for
channels that transition at a normat rate.

Long Eye finder looks at 2.5 million clock cycles on each
channel to determine the suggested sampling positions.
Use this setting if some channels have sporadic transitions.

Some things to consider when selecting among the eye finder
advanced settings are:

¢ Upper address bits that don't transition as frequently as lower address bits.
* Data buses that are driven by different circuitry at different times.

When different channels require different settings, you can run eye
Jinder on channel subsets to avoid using the Long setting on a large
number of channels.
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Eye Finder Option, Results Tab

The Eye Finder Results display is a digital "eye" diagram in that it
represents many samples of data captured in relation to the sampling
clock. The transitioning edges measured before and after the sampling
clock result in a picture that is eye-shaped.

You should have already specified the logic analyzer threshoeld voltage,
but you may adjust it to maximize the width of the measured stable
regions.

Eye finder measures the location of the stable region boundaries and
places the logic analyzer’'s sampling position in the center of the stable
region.

Suggested Position
L fromiEye ‘Finder! !

“For next analyzer: Run

File menun Lets you saveload eye finder data,

EyeFinder menu Lets you run eye finder, choose the run mode, and access
the “Eve Finder Advanced Seftings Dialog” on page 133.

134

www.valuetronics.com



Chapter 3: Reference
Importing Netlist and ASCH Files

Results menn  Let you expand/collapse the signals in a label, set the bus

view, set the sampling positions to the suggested sampling
positions, and remove all eye finder data.

Label buttons  Let you expand/collapse the signals in a label, set the bus

view, choose the suggested sampling position, and show
message or time stamp information.

Display Area Shows:

Transitioning {dark) and stable (light) regions on the signals.
Suggested sampling positions (green triangles).

The current sampling positions (blue lineg).

Informational message icons . You can move the mouse pointer over the
icon to cause the message to pop up.

Time stamp icons You can move the mouse pointer over the icon to
see when the last eye finder measurement was run,

To give you more information about the signals, the display
covers +/-b ns even though the sampling position may only
be set to +/-3.25 ns.

Sampling
Position Lets you adjust the sampling position. You can also drag the

See Also

sampling position bar o a new location.

“Understanding State Mode Sampling Positions” on page 208
*How Selected/Suggested Positions Behave” on page 135
“Eye Finder Run Messages” on page 136

“Eye Finder Info Messages” on page 139

“Eye Finder Load/Save Messages” on page 141

“Eye Finder Option, Setup Tab” on page 132

“To manually adjust sampling positions” on page 50

How Selected/Suggested Positions Behave. The eye finder's
selected and suggested sampling positions behave as follows:
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How the Selected Position Behaves

1. When eye finder is enabled, the selected position (blue line) is set based
on the manual setup/hold value.

2. Whenever the selected position is moved, the manual setup/hold value is
also updated. They always track each other.

3. When the manual setup/hold is enabled again, the position changes made
while eye finder was enabled can be kept or discarded.

NOTE: If eye finder changes are discarded, this includes any setup/hold settings
loaded from a configuration file while eye finder was enabled.

4, The selected position is "snapped" to the suggested position (green
triangle) each time the channel is measured.

How the Suggested Position Behaves

1. There is only a suggested position (green triangle) on channels that have
been measured.

2. The suggested position is always in the center of the stable region closest
to the selected position (blue line).

3. Ifthe selected position is moved to a different stable region, the suggested
position "hops® to the center of that region.

4. If a stable region is open-ended, the suggested position is placed 1.25 ns
from the closed end (the visible boundary). If more than 1 clock edge is
active, the suggested position is placed 1.5 ns from the closed end.

Eye Finder Run Messages. These messages can appear in the status
area after you run a eye finder measurement.

"XX% complete"

The indicated percentage of the channels selected for the current eye
Jinder measurement are completed.

“Cannot run the Eye Finder at this fime.”

A logic analyzer measurement is currently running. Stop the logic
analyzer or wait for it to complete before running eye finder.
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An eye finder measurement is currently running. Stop the eye finder
or wait for it to complete before running the eye finder.

The eye finder is already running on the other machine defined for
this analyzer. Eye finder carmot run on both machines at the same
time.

“Cannot run the Logic Analyzer at this time."

An eye finder measurement is currently running. Stop the eye firnder
measurement or wait for it to complete before running the logic
analyzer measurement, -

FEye finder uses the same hardware as an ordinary logic analyzer
measurement uses. Therefore, they cannot be performed at the same
time.

“"Characterizer cannot be loaded"

This is an internal error. It means that a software unit respongible for
measuring one of the channels did not fit the hardware setup and the
other characterizers which were already loaded. Try running eye
finder on just one label {or one channel) at a time to atternpt to clear it
up. Contact support if this persists.

“Complete: DATE"

The measurement completed successfully on the date and time given.
This time may also be accessed by expanding a label in the results
display and selecting the clock icon or selecting "Show Time Stamp” on
the popup menu raised by selecting the channel name in the results
display.

*Eye Finder anly cperates when the analyzer clocking is master clock (slave and/or

demux clocking are not supported).”

See the "Clock Setup"” section of the "Sampling" tab in the analyzer
setup window.

"Eye Finder only operates when the analyzer is setup for state analysis."

See the "Pod Assignment” dialog accessed from the "Format® tab in the
analyzer setup window.
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“From Eya Finder: After hardwars calibration, the sampling positions for the
fotlowing channels may have shifted out of the selected stable region by the
amount shown: CHANNEL: AMSUNT ps ... (NNN more)"

Fach time a measurement is started, the hardware is re-calibrated. The
new calibration values are checked against those used when the eye
finder measurements were taken. This message indicates that the
sampling positions for the given CHANNELs may have drifted out of
the stable region. The measurement is taken anyway, but you may want
to treat the results with caution and run eye finder again (or manually
adjust the sample position away from the indicated unstable region).

"Hardware calibration failed®

Something isn't as expected abowut the hardware and/or the cables and
connections between boards. To get detailed messages, start an
ordinary run or run PV,

“"Measurement Canceled”

The measurement was stopped. No change was made to the results
displayed. A run is stopped by user request or when the Sampling
Posifions dialog is closed or iconified.

“No labels defined with channels for the analyzer”

Define one or more labels with channels in the Format tab of the
analyzer's Setup window.

No labels are defined for the analyzer. Eye finder cannof be run until
one or more labels are defined with one or more channels assigned.

"No labels or channels selected for running Eye Finder.”
Select one or more labels in the "Eve Finder Setup" tab.

All labels defined for the analyzer are listed in the Eye Finder Setup
page. None are currently selected (selected labels are highlighted).
Select one or more labels for measurement by eye finder.

“Repetitive runs stapped”

The measurement was stopped. Data from the last measurement which
completed fully are retained. Repetitive runs are stopped by user
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request or when the Sampling Positions dialog is closed or iconified.

"Timeout: < N K clecks in 5 sec”

Eye finder requires stimulus at a minirnurn rate to perform its
measurements. Too few state clocks were seen in the time allotted.
Check clock inputs, clock definition, threshold voltage settings, and the
operation of the device under test.

Eye Finder Info Messages. These messages appear in the Eye
Finder Results tab after an eye finder measurement is run.

"Example measurement for demo. Results and settings will not be used for
analysis."

This channel was measured when "Use demo data (no probes
required)" was selected in the Settings tab. The data shown are typical
of eye finder operation, but the sample position setting shown is NOT
used. (The manual setting is still in use.)

"No activity present. Confirm cennection, stimulus, and threshold.”
This channel appears to be completely quiet.

¢ (Check the probe connection between the analyzer and the device under
test.

¢ Check the threshold voltage setting in the Format tab.

® Check that the device under test is turned on and is running the
appropriate diagnostic or other stimulus program.

if all these things are set up correctly, activity will be shown in the
Format tab.

"No stable regions. Is this the correct clock for this channel?”
Two common possibilities exist:

1. The signal on this channel is asynchronous to the clock defined for the
logic analyzer. If this is the case, there is no stable relationship between
the times when the signal switches and when the clock arrives.

If you expect the signal to be sampled synchronously you must redefine
the clock for this signal.
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2. The stable region{s) are too small for eye finder to detect.

in this case you must resort to adjusting the sample position manuaily and
checking its validity by running an ordinary analyzer measurement to see if
the data values you expect are sampled. You can adjust the sample position
manually by selecting the arrow buttons or by dragging the blue sampling
position indicator in the display.

"Only a few transitions defected. Change stimulus or increase measurement
daration (Advanced Settings)."

The signal on this channel was observed to toggle fewer than 500
times. The characterization may be accepted as it stands or you may
wish to change the stimulus program or diagnostic in the device under
test to increase the toggle rate.

Another option is fo select "Long" in the Eye Finder Advanced Settings
dialog (accessed from the "Advanced..." button on the Eye Finder
Setup tab or the "Advanced Settings..." menu pick under the EyeFinder
pull down menw). Using the "Long" setting won't necessarily make the
message go away, but it will ensure that eye finder has the opportunity
to observe a more significant number of transitions on the channel,

"Run Eye Finder te charactetize this channel."

Select this channel (or a label that contains it) and run eye finder to
characterize the channel. Only channels selected for a measurement
are updated when the measurement finishes. Information about other
channels is not changed.

“See individual channels for message(s}"

There is a message for one or more the the channels assigned to this
bus label. Expand the label (using either the popup menu on the label
in the display or the "Results" pulldown menu), then scroll down to the
channel with & message icon and display its message {either by
selecting the yellow message icon or by using the popup meni).

"The stable region extends beyond the limits of the display."

This channel is active, but the signal does not switch within b nsec
before or after the clock. For example, this could occur if the
propagation delay in the device under test from clock to data is greater
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than b nsec and the clock period is greater than 10 nsec (slower than
100 MHz).

Eye Finder Load/Save Messages. These messages can appear when
saving or loading eye finder data.
"... {at line XX in the file)"

Indicates where the error occurred in the file being read. Since eye
Jinder data files are ASCII text, you can use a text editor to examine
" the file at the indicated line fo determine how to repair the problem.

“Bad assigrment for XXX"
The numerical value for the item XXX could not be read.

*Cannot load Eye Finder data for a different module type. Data in file is from a
OTHERMODEL. This module is a THISMOBEL"

"Cannot load Eye Finder data for a module installed in different slots. Data infile is
fram a module installed in slots B A C. This module is installed in slots ED ",

"Cannot load Eye Finder data from a different instrument. Data in file is from
OTHERINSTRUMENT. This instrument is THISINSTRUMENT."

“Channel name in the data file ("OTHERNAME") does not match the expected
channel name {"'THISNAME"}."

“Channel number in the data file (NN} does not match the expected channel number
(MM).",

*Did not find: X)X (Search began at line LLL)"

The eye finder data file has a nested block structure. The next block
(or item) to be read was XXX, but it was not found before the end of
the file. The line after the last item successfully read was LLIL.

“Error in writing"

Disk is probably full.
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“Failed to open file for reading/writing: NAME"

The selected file could not be opened. Check access and file
permussions,

"File NAME already exists. Overwrite?

The selected file exists, Answering "Yes" will cause the existing
contents of the file to be replaced with current eye finder information.

"lavalid trueffalse flag”
The boolean value for the item could not be read. Boolean values start
with either a't’ or °’f ('T° or 'F’are also accepted),

"Master slot in the data file {'|’) does not match the expected master slot {'E’)."

“The number of channels in the data file (NNN} does not match the number of
channetls in the analyzer {(XXX}."

Eye finder characterizes the unique combination of the instrument,
module, cabling, probes, and Device Under Test. Results are not
transferable from one sifuation to another.

"Unsupported revision level (AABB)®

Something else is probably wrong because there aren’t any
unsupported versions.

Eye Finder Option, File Info Tab

When the Eye Finder option is selected, the File Info subtab lets you
gave and load eye finder data.
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File: Name of the eye finder data file.
Created: Date and time the eye finder data file was created,
Saved: Date and time the eye finder data file was last saved.

You are notified if the eye finder data has changed since the
last time it was saved.

Load... Loads eye finder data that was previously saved to a file.
Reload Reloads eye finder data from the named file, deleting
unsaved changes,
Save Saves current eye finder data to the named file.
Save As... Saves current eye finder data to a new file,
See Also “To automatically adjust sampling positions” on page 47
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Manual Setup/Hold Option

When you select Manual Setup/Hold,_the following options appear.

Label Selection
List

All bits
Individual bits
Bit:

Setup:

Hold:

Lets you select the label whose setup/hoid window will be
positioned.

Specifies that the setting is for all bits on the label,
Specifies that the sefting is for a single bit on the label.

When Individual bits is selected, this field idengifies the
single bit,
Specifies the front edge of the setup/hold window relative

to the sampling clock. Setup times are positive when the
position is before the sampling clock.

Specifies the back edge of the setup/hold window relative
to the sampling clock. Hold times are positive when the

144

www.valuetronics.com



Chapter 3; Reference
Importing Metlist and ASGH Files

position is affer the sampling clock.

See Also “To manually adjust sampling positions” on page 50
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The Trigger Tab

The Trigger tab is used to tell the analyzer when to capture data. The
key event is the irigger.

In the Agilent Technologies 16717A logic analyzer, you can insert
multiple trigger actions. When you insert multiple trigger actions, the
trigger marker in the display windows is placed on the first sample
whose evaluation caused a branch through an associated trigger action.

The Trigger tab has two main areas: On top, tabs of functions and
conirols to build your trigger; and beneath the tabs, the current trigger
sequence.

Some controls are also located in the logic analyzer window’s menu bar.
¢ “Trigger Functions Subtab” on page 147

e “Settings Subtab” on page 154

¢ “QOverview Subtab” on page 155

¢ “Default Storing Subtab” on page 156

s« “Status Subtab” on page 157
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“Save/Recall Subtab” on page 157

“Understanding Logic Analyzer Triggering” on page 192
“Setting Up Triggers and Running Measurements” on page 64
“Editing the Trigger Sequence” on page 72

Trigger Functions Subtab

rigger- function libraries

COcturrence

Trigger functions provide a simple way to set up the analyzer to trigger
on common events and conditions. A library of functions is available for
both state and téming measurements.

NOTE: Each trigger function requires at least one internal sequence level {see
page 72}, and in some cases, multiple levels, The number of levels used by
each function can be seen by breaking down or expanding the trigger
function.

See Alse ®

“General Timing Trigger Functions™ on page 148
“General State Trigger Functions” on page 150
“Advanced Trigger Functions” on page 153

“Using Trigger Functions” on page 65
“Bditing Advanced Trigge'r Fenctions” on page 77
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General Timing Trigger Functions

The following general trigger functions are found in the Trigger
Fumnctions tab when the logic analyzer is in the timing sampling mode.

You can edit most of the trigger functions to specify particular pattern
and edge events.

You can break down a trigger function to see how many advanced
sequence levels are used.

Find pattern

Becomes true when a pattern occurs one time.

Find edge

Becomes true when the specified edge occurs in one sample,
Find edge AND pattern

Becomes true when the specified pattern and the specified edge occurs in
one sample.

Find width violation on a pattern/pulse

Becomes true when the width of a pattern violates minimum and
maximum width specifications.

Find Nth occurrence of an edge

Becomes true when the specified edge occurs in the specified number of
samples.

Find pattern present/absent for > duration

Becomes true when the specified pattern is present or absent for greater
than the amount of time specified.

Find pattern present/absent for < duration

Becomes true when the specified pattern is present or absent for less than
the amount of time specified.

Run until user stop

Sets up to never trigger. You must select the stop button to view the
captured data.
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Find 2 edges too close together

Becomes true when the second specified edge occurs within a specified
time after the first specified edge.

Find 2 edges too far apart

Becomes true when the second specified edge does not occur within a
specified time after the first specified edge.

Find pattern occurring too soon after edge

Becomes frue when a specified pattern occurs within a specified time after
the first specified edge.

Find pattern occurring too late after edge

Becomes true when a specified pattern does not occur within a specified
time after the first specified edge.

Find glitch

Becomes true when the specified glitch oceurs in one sample.
Wait t seconds

Becomes true when the specified amount of time has expired.
Wait for arm in

When the logic analyzer is armed by another instrument (as specified in
the Intermodule window), this trigger function becomes true when the
arm signal is received.

Wait for second analyzer to trigger

‘When the logic analyzer's pods are assigned to two analyzers, this trigger
function becomes true when the other analyzer triggers.

Wait for flag

Becomes true when the specified flag has the specified value. This trigger
function tests for a flag event.

Set/clear/pulse flag

Becomes true on any sample and sets, clears, pulse sets, or pulse clears
the specified flag, This trigger function inserts a flag action.
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¢ OR Trigger

When the logic analyzer is armed by another instrument (as specified in
the Intermedule window), this trigger function becomes true when a
pattern occurs a specified number of times OR when the arm signal is
received.

See Also “To specify a label pattern event” on page 66
*To specify a label edge event” on page 67
“To break down a trigger function” on page 67
“To cross-trigger with another instrument” on page 107

*To cross-trigger between two analyzers” on page 106

General State Trigger Functions

The following general trigger functions are found in the Trigger
Functions tab when the logic analyzer is in the state sampling mode.

You can edit most of the trigger functions to specify particular pattern
events.

You can break down a trigger function to see how many advanced
sequence levels are used.

¢ Find pattern n times

Becomes true when the specified pattern occurs in the specified number
of sampies {eventuaily).

s Store range until pattern occurs

Becomes true when the specified pattern ocecurs in the specified number
of samples {eventuaily) and only stores sampies in the specified range
until then.

* Store patiern2 until patternl occurs

Becomes true when the first specified pattern occurs in the specified
number of samples {eventually) and only stores sampies with the second
specified pattern until then.

=  While storing patte